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FOREWORD

The Government of India has set an ambitious target of imparting skills to 30 crores people, one out of every
four Indians, by 2020 to help them secure jobs as part of the National Skills Development Policy. Industrial
Training Institutes (ITIs) play a vital role in this process especially in terms of providing skilled manpower.
Keeping this in mind, and for providing the current industry relevant skill training to Trainees, ITI syllabus
has been recently updated with the help of Mentor Councils comprising various stakeholders, viz., Industries,
Entrepreneurs, Academicians and representatives from ITIs.
The National Instructional Media Institute (NIMI), Chennai, has now come up with instructional material to
suit the revised curriculum for Secretarial Practice (English), 1st Semester Trade Theory NSQF
Level- 4 in Travel, Tourism & Hospitality Sector under Semester Pattern. The NSQF Level - 4 Trade
Practical will help the trainees to get an international equivalency standard where their skill, proficiency and
competency will be duly recognized across the globe and this will also increase the scope of recognition
of prior learning. NSQF Level - 4 trainees will also get the opportunities to promote life-long learning and skill
development. I have no doubt that with NSQF Level - 4 the trainers and trainees of ITIs, and all stakeholders
will derive maximum benefits from these Instructional Media Packages (IMPs) and that NIMI's effort will go
a long way in improving the quality of Vocational training in the country.
The Executive Director & Staff of NIMI and members of Media Development Committee deserve appreciation
for their contribution in bringing out this publication.
Jai Hind

RAJESH AGGARWAL

Director General/ Addl.Secretary
Ministry of Skill Development & Entrepreneurship,
Government of India.

New Delhi - 110 001
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PREFACE
The National Instructional Media Institute (NIMI) was established in 1986 at Chennai by the then Directorate
General of Employment and Training (D.G.E & T), Ministry of Labour and Employment, (now under Directorate
General of Training, Ministry of Skill Development and Entrepreneurship) Government of India, with technical
assistance from the Govt. of the Federal Republic of Germany. The prime objective of this institute is to
develop and provide instructional materials for various trades as per the prescribed syllabi (NSQF Level 4)
under the Craftsmen and Apprenticeship Training Schemes.
The instructional materials are created keeping in mind, the main objective of Vocational Training under
NCVT/NAC in India, which is to help an individual to master skills to do a job. The instructional materials are
generated in the form of Instructional Media Packages (IMPs). An IMP consists of Theory book, Practical
book, Test and Assignment book, Instructor Guide, Audio Visual Aid (Wall charts and Transparencies) and
other support materials.
The trade practical book consists of a series of exercises to be completed by the trainees in the workshop.
These exercises are designed to ensure that all the skills in the prescribed syllabus are covered. The trade
theory book provides related theoretical knowledge required to enable the trainee to do a job. The test and
assignments will enable the instructor to give assignments for the evaluation of the performance of a trainee.
The wall charts and transparencies are unique, as they not only help the instructor to effectively present a
topic but also help him to assess the trainee's understanding. The instructor guide enables the instructor to
plan his schedule of instruction, plan the raw material requirements, day to day lessons and demonstrations.
In order to perform the skills in a productive manner instructional videos are embedded in QR code of the
exercise in this instructional material so as to integrate the skill learning with the procedural practical steps
given in the exercise. The instructional videos will improve the quality of standard on practical training and
will motivate the trainees to focus and perform the skill seamlessly.
IMPs also deal with the complex skills required to be developed for effective team work. Necessary care
has also been taken to include important skill areas of allied trades as prescribed in the syllabus.
The availability of a complete Instructional Media Package in an institute helps both the trainer and
management to impart effective training.
The IMPs are the outcome of collective efforts of the staff members of NIMI and the members of the Media
Development Committees specially drawn from Public and Private sector industries, various training institutes
under the Directorate General of Training (DGT), Government and Private ITIs.
NIMI would like to take this opportunity to convey sincere thanks to the Directors of Employment & Training
of various State Governments, Training Departments of Industries both in the Public and Private sectors,
Officers of DGT and DGT field institutes, proof readers, individual media developers and coordinators, but for
whose active support NIMI would not have been able to bring out this material.

R. P. DHINGRA
EXECUTIVE DIRECTOR

Chennai - 600 032
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INTRODUCTION
TRADE THEORY
The manual of trade theory consists of theoretical information for the First Semester course of the Secretarial
Practice (English) Trade. The contents are sequenced according to the practical exercise contained in the
manual on Trade practical. Attempt has been made to relate the theoretical aspects with the skill covered in
each exercise to the extent possible. This co-relation is maintained to help the trainees to develop the
perceptional capabilities for performing the skills.
The Trade Theory has to be taught and learnt along with the corresponding exercise contained in the manual
on trade practical. The indications about the corresponding practical exercise are given in every sheet of this
manual.
It will be preferable to teach/learn the trade theory connected to each exercise atleast one class before
performing the related skills in the shop floor. The trade theory is to be treated as an integrated part of each
exercise.
The material is not for the purpose of self learning and should be considered as supplementary to class room
instruction.

TRADE PRACTICAL
The trade practical manual is intended to be used in workshop . It consists of a series of practical exercises
to be completed by the trainees during the First Semester course of the Secretarial Practice (English) trade
supplemented and supported by instructions/informations to assist in performing the exercises. These
exercises are designed to ensure that all the skills in the prescribed syllabus are covered.
The manual is divided into Five modules. The distribution of time for the practical in the Five modules are given
below.
Module 1

Shorthand practice and windows operating system

Module 2

Formation of words, phrases, and practice of MS-Word

Module 3

Speed enhancing techniques in S H and practice on computer

200 Hrs

Module 4

Prefixes & suffixes, Monetary units & dictation

125 Hrs

Module 5

Proficiency in note-taking and transcription on computer
Total

150 Hrs
50 Hrs

75 Hrs
600 Hrs

The skill training in the computer lab is planned through a series of practical exercises centred around some
practical project. However, there are a few instances where the individual exercise does not form a part of
project.
While developing the practical manual a sincere effort was made to prepare each exercise which will be easy
to understand and to carry out even by a below average trainee. However, the development team accepts that
there is scope for further improvement. NIMI, looks forward to the suggestions from the experienced training
faculty for improving the manual.
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Module 1: Shorthand practice and windows Operating System
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LEARNING / ASSESSABLE OUTCOME
On completion of this book you shall be able to
•

Familiarisation with shorthand and computer application

•

Sentence Preparation using logograms/ grammalogues, contractions tick ‘the’ &
punctuation marks etc.

•

Knowledge of Windows operating system

•

Use up and down strokes of R&H, and Abbreviated ‘W’

•

Use of small and large circles, small & large loops and MS Word applying all tools

•

Direction of SHR, SHL and alternative forms

•

Double consonants and compound consonants

•

Recognition of different types of hooks

•

Application of halving and doubling principles

•

Application of prefixes & suffixes

•

Identification and use of monetary units and round figures

•

Employing Contractions effectively while note taking

•

Awareness of simple letter writing methods & note taking techniques.

•

Understanding of similar outlines with different meanings and spellings.

(ix)
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SYLLABUS-SECRETARIAL PRACTICE (ENGLISH)
FIRST SEMESTER – 06 Months
Week
No.
1-4

Reference Learning
Outcome
Familiarisation with shorthand
and computer application.

Professional Skills
(Trade Practical)
With Indicative Hours
1. Practice of the Consonants
according to their pairs and
dictation thereof. (25 hrs)
2. Practice of joining stroke
consonants. (25 hrs)
3. Practicing of Long and Short
Vowels, Dot & Dash Vowels,
Preceding and Following
vowels, Intervening Vowels,
etc. and dictation of the same.
(25 hrs)
Computer:
4. Awareness of the computer
hardware in the lab and its
peripherals to accustom the
trainees for use of computer.
(25 hrs)

Professional Knowledge
(Trade Theory)
Introduction, Job Opportunities &
Scope of the Trade.
Introduction
to
Shorthand,
Consonants:
Definition,
Classification, arrangements and
directions, table of consonants,
Joining of Strokes
Vowels: Long & Short Vowels, Dot &
Dash Vowels, Places of Vowels,
following and preceding vowels,
Intermediate vowel, places of vowels
for joined strokes.
Computer Fundamentals:
Introduction, Definition, Utility, types
and applications of Computers.
Computer:
Hardware: Definition & Introduction,
Motherboard, Processor, Input &
Output Devices and Storage devices.
Software: Definition & types of
Software.

5-6

Prepare a complete sentence
with use of logograms
grammalogues, contractions,
tick ‘The’ & punctuation.

5. Practicing of Logograms,
Grammalogues, & Contractions,
with the use of tick ‘The’ and
Punctuation marks. (15 hrs)

Short
Forms:
Logograms,
Grammalogues, & Contractions, Use
of tick ‘The’ in phrasing, Use of
Punctuation Marks.

Acquire knowledge of Windows
operating system

6. Practice of Diphthongs and
Triphones. (15 hrs)

Computer Windows Operating
System: Introduction, Log on
accounts, Passwords, Minimizing,
Windows resizing, Moving, Closing
Windows, Windows Menu, Tool Bar,
Task Bar, menu bar and Start Button,
Shutting down Windows. Desktop,
Windows Explorer, Control Buttons
Open, Cut, Copy & Paste, etc.

Computer:
7. Practical use of Windows
Operating System. (10 hrs)
8. Familiarisation with Computer
Keyboard keys. (10 hrs)

Diphthongs:
Definition, Signs and Places of
Diphthongs and Triphones
Computer Keyboard Functions.
7-8

Identify the strokes R & H,
Abbreviated W.

9. Practice of Alternative Forms
of R & H. (10 hrs)
10. Practice of Abbreviated W,.
(10 hrs)

Alternative forms of R & H
Strokes,
b) Thick Downward R & H.
c) Alternative forms & their uses:
Abbreviated W, Diphone

11. Use of downward H, Tick H
and Dot H and upward SH and
dictation. (5 hrs)
(x)
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Week
Week
No.
No.

Reference Learning
Learning
Reference
Outcome
Outcome

Professional Skills
Skills
Professional
(Trade Practical)
Practical)
(Trade
With Indicative
Indicative Hours
Hours
With

Professional Knowledge
Knowledge
Professional
(Trade Theory)
Theory)
(Trade

12. Practice of Phraseography d) Computer keyboard Operations:
and dictation (5hrs)
Aspirate H : Tick & Dot H, Downward
13. Computer: Practice of the H Stroke & Upward Sh Stroke.
sitting posture on computer and Phraseography- Formation of
finger positioning on the Simple Phrases.
keyboard. (10hrs)
Computer:
14. Computer Typing practice
on Computer and Creation of MS- Word - Creation of File and use
MS Word file on Computer with of various tools.
the use of various options of
MS- Word. (10hrs)
9

Identify small circle for S & Z,
Large circle for SW/large loop &
small loop understand MS Word
by using all tools.

15. Practice of Small Circle for
S & Z, Use of circle S & Z with
other stroke Consonants and
dictation. (10hrs)
Computer Speed Typing:
16. Practice typing using typing
tutor. (15hrs)

10

The Circle: Small circle for S & Z,
Circle and the strokes, Circle S with
H stroke, Stroke L and circle S.
Computer Speed Typing: Speed
Calculation, Signs & Symbols,
Roman Numbers, Capitalizations of
Letters, Display, Counting Errors and
calculating speed and errors,
Evaluation & Marking Scheme.

16. Demonstrate:

a) Large Circle:

a) Large Circle – SW, SS, SZ
and their uses medially and
finally uses and dictation. (05
hrs)

Large Initial Circle for SW,SS, SZ

b) Small Loop for ST/SD. (04
hrs)

Use of large circle, medially and
finally, Circle and vowel places.
b) The loops:
Small Loop of ST/SD

c) Large loop of STR and
dictation. (04 hrs)

Large loop for STR

Computer:

MS Word- editing and formatting

17. Practice in MS-Word and
its options. (06 hrs)

Computer:

18. Practice typing using
11

Recognize the direction of SHR,
SHL and alternative forms.

typing tutor. (06 hrs)
17. Practice of Initial small
hooks for R & L. (06 hrs)
19. Apply the above on different
types of sentences (11 hrs)
Computer:
20. Practice on Computer for
Speed Typing (08 hrs)

(xi)

Initial small hooks (Double
Consonants): R & L Hooks, SHR &
SHL hooked strokes, Vowels and
double consonants
Computer:
Setting indents and spacing, Use of
help Options, Page Set up, Margins,
Ruler, and Paper Size in Word.
Inserting Lines and Page Breaks,
Viewing Documents Properties and
Printing, Use of Tables, Insertion and
Deletion of Rows and Columns,
Alignments between Rows & Columns
and other MS- Word Features.
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Week
Week
No.
No.
12

Reference
Reference Learning
Learning
Outcome
Outcome
Observe curved hook and
compound consonants.

Professional
Professional Skills
Skills
(Trade Practical)
Practical)
(Trade
With Indicative
Indicative Hours
Hours
With

Professional
Professional Knowledge
Knowledge
(Trade Theory)
Theory)
(Trade

Alternative forms of curved
hooked strokes, Left & Right Curves
a) Curved hooked strokes for of f/v/th/TH, upward SH with hooked
F/V/ith/TH. (04 hrs)
strokes, intervening vowels, circles
b) Develop new sentences to and hooks
follow the above rules (04 hrs)
Compound Consonants: Initial large
21. Compound Consonants and hooks of WH/WHL/KY/GY/KW/
develop WH/ WHL/ KY/ GY/ GW/MP/MB strokes.
KW/GW/ MP/ MB and apply on
different types of words. (04
hrs)
18. Demonstrate:

Computer:
22. Typing Practice of passages
from books, magazines, journal
and newspaper for enhancing
the speed and accuracy.(13 hrs)
13

Recognize different types of 19. Construct:
hooks
Final hook N and F/V and apply
it on various types of sentences
(09 hrs)
23. Shun Hook and join with
other Strokes and apply it on
the different types of sentences.
(09 hrs)

Final Hooks: N & F/V small hooks,
Hooks and Vowels, Circles and
Loops with finally hooked strokes.
Large Final Hook: (Shun Hook)
Use of Shun after Circle, Use of shun
hook after certain strokes.

Computer:
24. Practice on Computer for
Speed Typing (07 hrs)
14-15

Develop new sentences by
applying halving/doubling
principles.

20. Demonstrate Halving
Principles on different types of
words & sentences (20 hrs)
21. Halving of other compound
consonants and application on
Computer for Speed Typing.
(20 hrs)

Halving Principles: Halving of
Strokes for T or D, Halving of M,N,L,R,
for D, Halving of hooked MP/MB/NG
etc.

25. Practice pairs of words
confused and misused. (10 hrs)
16

17-18

Apply the prefixes.

26. Practice of Doubling
Principles, Doubling of other
compound consonants and
dictation (10 hrs)
Computer:
27. Practice on Computer for
Speed Typing (15 hrs)

Doubling Principles: Doubling of
Strokes for TR & DR, Doubling of
MP/MB/NG and L Strokes.

28. Practice of Prefixes and
their representative strokes and
Dictation. (25 hrs)
Computer :
29. Practice on Computer for
Speed Typing (25 hrs)

Prefixes-definition, Use and
representative lines

(xii)
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Week
Week
No.
No.
19-20

Reference
Reference Learning
Learning
Outcome
Outcome
Apply the suffixes

Professional
Professional Skills
Skills
(Trade Practical)
Practical)
(Trade
With Indicative
Indicative Hours
Hours
With
30. Practice of Suffixes and
their representative strokes and
Dictation(25 hrs)

Professional
Professional Knowledge
Knowledge
(Trade
Theory)
(Trade Theory)
Suffixes: Definition, Use and
representative lines

Computer :
31. Practice on Computer for
Speed Typing (25 hrs)

21

Identify the monetary units &
use them.

22. Explain the figuresa)
a) Monetary Units & Round
Figures and use it on
sentences. (06 hrs)

Intersection- Monetary Units &
Round Figures
Contractions- formation and uses,
Essential Vowels.

b) Contractions- formation and
uses, Essential Vowels and
dictation (06 hrs)
32. Develop the sentences to
follow above rules. Write in
shorthand & apply on Computer
for Speed Typing. (13 hrs)

22-23

Apply note-taking techniques.

33. Practice of Simple Letters
writing in shorthand and Useful
Note Taking Techniques (30
hrs)

Simple letter writing

Computer:
34. Practice on Computer for
Speed Typing (20 hrs)

24

35. Practice of Translation &
Note Taking Techniques. (13
hrs)

Translation & Note Taking Techniques

Computer:
36. Practice on Computer for
Speed Typing (12 hrs)

25

Project work/Industrial visit

26

Revision & Examination

Note
1 One hour soft skill classes to be arranged on a daily basis. Some of the sample project works (indicative only) are
given against each semester.
2 The instructor may design his own project.
3 The project should broadly cover maximum skills in the particular trade and must involve some problem solving skill.
Emphasis should be on Teamwork: Knowing the power of synergy/ collaboration, work to be assigned to a group (Group
of at least 4 trainees). The group should demonstrate Planning, Execution, Contribution and Application of Learning.
They need to submit a project report.
4 If the instructor feels that for the execution of a specific project more time is required them he may plan accordingly
to produce components/ sub-assemblies in appropriate time, i.e., may be in the previous semester or during execution
of normal trade practical.

(xiii)
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.1.01
Secretarial Practice (English) - Shorthand practice and windows operation system
Professional knowledge - Introduction, job opportunities & scope of the
trade
Objectives: At the end of this lesson you shall be able to
• explain the duties and resposibilities of a sceretary
• state the functions of a private secretary
• list the opportunities available.
Introduction to Secretarial Practice

Job opportunities & scope of the trade

The term 'Secretarial Practice' has been used to include
knowledge, skills, procedure, and methods of work to be
performed by a private secretary or office assistant. Persons with secretarial skills find employment in all types
of offices eg. Govt, public or private, different types of
agencies, etc., in big and small cities. The application of
modern technology advancements has brought about revolution and greater effectiveness in day-to-day working of
the offices. Due to this, procedures have become more
streamlined and office work has become more interesting
and challenging.

Through modern office secretarial practice course, computer training is provided to candidates for complete office
management and to support the work of senior officers.
Clearly offices cannot function effectively without specially
trained professionals; such jobs are available in Government as well as in private sector. Therefore finding a job is
never a problem.

Objectives
This course aims at enabling a learner to understand the
nature of duties and responsibilities of a secretary, develops essential skills in performing secretarial tasks, helps
understand the organisation structure and develops skill
in handling office machines and equipment.

Once you have trained in secretarial practice course, you
can work as private secretary or personal assistant in multinational companies, private offices, banks, institutes,
colleges, schools, social organizations, etc.
In addition to the above job opportunities jobs are also
available in secretariats, state as well as Parliament.
Teaching job opportunities are also available in Government Industrial Training Institutes and Institutions governed
by the Union Government, viz., RVTI, etc.
In short, candidates who are trained in Secretarial Practice can get well paid jobs and can also venture for self
employment such as secretarial work on contract basis to
organisations which do not employ full time secretaries.

Introduction to Shorthand
Objectives: At the end of this lesson you shall be able to
• state the history of shorthand
• explain shorthand & its utility
• distinguish between stenography/ shorthand & typewriting
• understand the general instructions for writing of shorthand outlines
• explain shorthand & its utility
• distinguish between stenography/ shorthand & typewriting.
Brief history of Shorthand
The origin and development of shorthand lies buried in
antiquity. Shorthand has been variously known and practised as Tachygraphy (quick writing), Brachygraphy (short
writing), Zeiglographia, Semography, Stenography or Shorthand (narrow-writing) and hundreds of shorthand systems
have been experimented and used since time immemorial.
Sir Isaac Pitman published his book on Shorthand in 1837,
which was later called "Phonography" or Sound writing
"Pitman shorthand" the invention of pitman’s phonetic
system, nearly 460 systems of English Shorthand writing
had been tried in England alone without much success.

Thus, Pitman shorthand, which was developed 175 years
ago on the phonetic structure of Sanskrit holds good even
to-day. After the use of Pitman's system efforts were continued for developing simpler systems of shorthand. In 1884
J.M. Sloan of England and Duployan from France, published the Sloan Duployan system. In this system vowels
are joined to strokes.
After the publication of this system John Robert Gregg
published his system of shorthand in 1888 based on the
long hand style. This system became popular in the
United States. In this system there is no position writing.
This system has not become popular in India.
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1

Shorthand & its utility

Instructions for Shorthand Writing

Language is used in two forms, written and phonetic (oral).
Script is essential for a beautiful language. For speedy
transmission of thoughts, a short - and facile script is
very essential. Shorthand is to say the script in which we
can write and transmit our thoughts at the maximum
speed. In shorthand, "words are being written according
to their sounds". Shorthand is a script with which human
thoughts can be recorded quickly and effectively. It is
recording the speed with which a man can speak out his
thoughts for the benefit of others. "Thus speed and accuracy are the prime factors for any shorthand system".

Follow these instructions carefully for each exercise and
Practise the outlines given in the book by way of examples.
•

Write 6 to 8 outlines in a line as given in the Practice
exercises. Copy these in fine handwriting.

•

Keep the size of the strokes/lines equal, i.e., 3/4 cms
approx.

•

Make distinction between light and dark strokes, by
writing light strokes with light pressure and dark strokes
with a little more pressure of the Shorthand pencil.

•

• Shorthand was used to write the sermons of religious

Use only Shorthand Note Book for practice; unlike other
noteboods turning of pages of shorthand note book
requires practice.

•

Follow the right direction for writing strokes and signs
as given in the Practice Exercises.

• It was used for 'notations' or marginal notes in public

Shorthand writing equipments

• Qatibs were used to take Shahi Fermans (orders of

The following equipments/material is required for a learner/
writer of Shorthand.

The utility of shorthand is not new to human history. It has
been used for various purposes since its beginning.
leaders of the church.

documents to protect them against forgery.
kings) in Mughal period.

• Samuel Papys recorded his diary in shorthand.
• George Bernard Shaw wrote all his literature in shorthand.

• Famous Novelist Charles Dickens was a shorthand
reporter first.

• Shakespeare’s plays were all preserved by means of
shorthand.

• Julius Caesar is also known to have written in shorthand.

• The mythological story of writing Mahabharata by Lord

Ganesh taking dictation from Vyasa also indicates a
system of shorthand writing in ancient India.

Now a days, shorthand is used to record the proceedings
of the legislative bodies, testimony of law courts for literary work, business correspondence, etc., Its importance
has been recognized by scholars, linguistics, phoneticians
and political leaders also.
Stenography (Shorthand &Typwriting)
The art of stenography means to write a communication
in shorthand and then transcribe it in the respective language script. Thus the art of stenography includes both
shorthand and typewriting. That is why it is referred to as
twin arts.

• The other writing system like shorthand is Morse code,
an old telegraphic script based on dots and dashes.

• There is another script called Braille code - meant for
the blind which uses only dots to represent any spoken language of the world.

Table & Chair
The writing table should be approximately 75 centimetres
high and the chair around 45 centimetres high so that the
writer can sit comfortably while writing. This height may
vary with the height of the Shorthand writer.
Note Book
A standard Shorthand notebook containing about 100
leaves or 200 pages is an ideal notebook for Shorthand
writing. A rubber band around the used leaves will make
opening of the book easy. The students should learn the
method of turning 1. pages with the left hand gradually so
that the right hand is not disturbed while writing. The left
hand should move the page line by line.
Pencil/Pen
In the beginning a neat style of writing with a Shorthand
pencil should be adopted so that the thick and thin outlines are clearly visible. With the acquaintance of strokes/
outlines, a Shorthand Pen with a fine and flexible nib can
be used for flowy writing.
Pen or pencil should be held lightly between fingers of the
right hand so as to permit facile writing. The middle of the
fore-arm should rest on the edge of the desk so that free
movement of the wrist of the right hand is allowed. The
writer should keep his/her notebook parallel to the edge of
the table, pressed firmly by the left hand fingers.
Stop Watch or Wrist Watch
The dictator should have a Stop Watch or a Wrist Watch
with seconds bar so that the dictation speed is regulated
properly by checking at every quarter of a minute which is
marked in the dictation passage. The dictation should be
given loudly so that there is no element of mishearing by
the students.

These writing systems were also developed based on the
phonetic concept of shorthand.
2
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Typewriter/Computer
A mechanical/electrical/electronic typewriter or a computer
is necessary for a Stenographer for proper transcription of
his/her notes. The typewriter must be in perfect working
condition and should be maintained properly. Eraser/
Erasex is allowed in transcription.
Cassette Recorder/Audio Recording Systems

•

The student should master the logograms,
grammalogues, contractions and phrases and maintain the clarity of his outlines. His ability to mark full
stops, paragraphs and proper turning of pages of the
Shorthand notebook would also be helpful to render a
good transcription.

•

The Shorthand writer should have patience and should
never lose concentration during dictation. He should
have sharp hearing and alertness of mind. He should
have adequate knowledge of the terminology of the
department where he is working. He should make use
of the available aids for high speed writing such as
Tape Recorders, Slow Speed News Bulletins of A.I.R.,
TV., in addition to his classroom dictations. He should
clear all doubts about the correctness of outlines from
his teacher or colleagues.

•

Too much movement of hand and paper shifting is time
consuming. It shows the nervousness of the Shorhand
writer. The size of the outlines given in this book is
nearest the ideal. The ideal should not be to make the
heavy strokes heavier but to make the light strokes
lighter. This will enable the free movement of hand in
speed writing.

•

Phraseography is an essential element of Shorthand
without which its purpose cannot be achieved. Good
phrases are those where the outlines are joined easily,
legibly with forward motion of hand. Phrase-formation
should be governed by certain rules of Shorthand and
knowledge of the language. Students should not try to
manufacture their own phrases. Distinction should be
made between phrases having grammatical variations
by putting vowels. Phrases should be thoroughly practised. Judicious use of phrasing is one of the important factors of Stenography.

It is a useful electronic device prescribed in the syllabus.
Use dictation cassettes for self-dictation & transcription
to get quick and desired results.
Valuable Tips for a Shorthand Writer
Shorthand is the only art which has immediate and attractive job opportunities. Mere writing at speed is not the
sole purpose of Shorthand writers. It is an acquired art
(knowledge) for the development of which one has to put
in hard labour to make it perfect. The Stenographer is not
only required to give a literal transcription but should also
be able to give a summary, an abridgement, a precis, a
concise and condensed note of every matter dictated. In a
business or professional life, practice of this sort is necessary in addition to his ordinary speed practice. The
ideal stenographer does not make the context too short
or too long. He should remember:
•

Shorthand is a delicate and fascinating craft of speed
and beauty, exemplified in the quality and legibility of
outlines and the power to record and transcribe the
whole communication correctly, at a speed with which
a man can speak out his thoughts clearly.

•

The students of Shorthand must develop a spirit of
competition which should be maintained throughout the
study to achieve the goal and bring the desired results.
Once a keen start is developed the knowledge of the
subject automatically improves and the love for the
subject ushers in.

•

A Shorthand writer should be a good receiver and good
reproducer for which he must have a sound base of the
language, combined with general knowledge. When
complicated problems arise, ideas and solutions sometimes have a tendency suddenly to appear and get
lost into oblivion if not recorded immediately. Shorthand writer helps to photograph the various workings
of the mind and capture the fleeing thoughts.

•

The student of Shorthand must have a sound knowledge of the language concerned, without which he may
be prone to make mistakes in the transcript, i.e., spelling, meaning, punctuation, etc. The student should
keep on learning the language side by side, if he is
weak in language.

If these instructions are followed strictly, the task of shorthand writers will become easy.
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.1.02
Secretarial Practice (English) - Shorthand practice and windows operation system
Consonants: Definition, Classification, Arrangements and Directions, Table
of consonants, Joining of strokes
Objectives: At the end of this lesson you shall be able to
• define consonants
• list the number of consonants in shorthand
• describe the classification of the consonants
• narrate the pairs and arrangement of consonants
• state the size and directions of shorthand strokes
• join the consonants/strokes.
Definition of consonants
"Consonants are the result of audible friction in some part of the mouth or throat", by -Prof. Sweet. According to Indian
Linguists - "Consonants are the body of a language and vowels are its soul".
Consonants
According to Indian Linguists, Consonants are the body of a language and vowels are its soul. In fact no language can
exist without them. They are so inter-related that no consonant can be used in a language without a vowel and no vowel
can be used in a language without a consonant. In Shorthand consonants are the body (Strokes) on which the soul (vowel
signs) can be put. Therefore, Consonants have a major role in Shorthand (phonetic) writing, while vowels can be omitted
subject to rules of theory.
The Consonants (strokes) are phonetic units (syllables) of the language and are not fully dependent on the Consonant
letters of English language. Therefore, a phonetic stroke of Shorthand can represent one or more consonant letters of
English, e.g., the Stroke of K represents the sounds of C (call), Q (queen), K (king) and Ch (chemist); the Stroke of J
represents the sounds of J (Jolly) and G (Geography); the stroke of S represents S (see, sea) and C (cite, cease); the

stroke of Z represents X (Xerox), C (Czar) and Z (zero); while the single stroke sound of (‘/’), Ch, ‘)’ Sh, ‘(‘ Th or ‘(‘ Thee
is represented by two or more consonant-letters of English. Therefore, Shorthand script has less consonantal strokes
and has certain limitations compared to the longhand script.
There are only 24 consonants in English shorthand as - P,B,T,D, CH, J, K, G, M, N, NG, F, V, th, THE, S, Z, SH, ZH, L,
R, W, Y, H.
Pairs and arrangement of consonants
The consonantal strokes of English Shorthand have been paired into light and heavy strokes according to their phonetic
sounds. There are, first sixteen consonants in pairs, thus, P/B, T/D,CH/J, K/G, F/V,ith/THE, S/Z, SH/ZH. The articulations in these pairs are the same but the sound is light for the first consonant of each pair and heavy sound for the second
consonant of each pair.
The consonants of each pair are represented by the same strokes, but for the second consonant this is written thick
instead of thin, as P,B etc., We have therefore a light sign for the light sound and heavy sign(Thick Sign) for the heavy
sound.
The consonants, M,N,R, L, W, Y, H do not have phonetic pairs and are represented by light strokes according to their
phonetic sounds. The consonant NG does not have pair but it is written thick instead of thin since the sound of this
consonant is heavy.

For the representation of all the consonantal sounds (except W,Y,H) the simplest geometrical forms are used, namely,
the straight line and shallow curve. Those strokes formed by part of a straight line are called straight strokes while
strokes formed by part of a circle are called curved strokes as shown in the following diagrams.

Straight Strokes
4

Curved Strokes
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Size and directions of stroke consonants
The consonants should be written about 2/3 of the length of shorthand notebook linespace. Shorthand strokes are written
in three directions and are called
i

Downward strokes,

ii

Horizontal strokes and

iii Upward strokes.
Strokes are written with the shorthand pencil with light and heavy touch according to their, light or heavy sounds, Heavy
strokes are never written upwards.
Classification of consonants
There are only six classes of consonants
i

Plosives (Explodents): The first eight consonants (P,B,T,D,CH,J,K,G) are plosives, because in pronouncing them
the outgoing air passes through the barriers of the mouth suddenly.

ii Fricatives (Continuants): The next eight consonants (F,V, th, THE, S,Z, SH, ZH) are called fricatives (Continuants)
because in pronouncing them the outgoing breath passes slowly in a continuous stream through the mouth barriers.

iii Nasals: The next three consonants (M,N,NG) are called nasals as in pronouncing them the air passes through the
nose also.
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iv Liquids: The consonants L and R are called liquids, which flow into union with the other consonants and thus make
double consonants as cliff, dry, etc., (where the L or R unites with the preceding consonants)
Letter

Sound Character/Stroke

Example (as in)

L

el

……..

(Up)

life

R

ar

……..

(Down)

Arm

R

ray

……..

(Up)

right

v Coalescents: W & Y are semi-vowels (coalescents), precede vowels and coalesee or unite with them.
Letter

Sound Character/Stroke

Example (as in)

W

way

……..

(Up)

wage

Y

yay

……..

(Up)

yellow

vi Aspirate: The consonant H is aspirate, which is a breathing upon a following vowel.
Letter
H

Sound
hay

Character/Stroke Example (as in)
…….. (Up)

hope

…….. (Down)

he

Joining of strokes
Strokes when joined must be written without lifting the pen. The beginning of a following stroke should be joined to the end
of a preceding stroke, asP, PR, PT, PH …………..........…………

6
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.1.03
Secretarial Practice (English) - Shorthand practice and windows operation system
Vowels: Long and Short Vowels, Dot & Dash Vowels, places of Vowels,
following and preceding vowels, intermediate vowels, places of vowels for
joined strokes
Objectives: At the end of this lesson you shall be able to
• define a 'vowel'
• explain the vowel sounds, signs & places
• determine the preceding and following vowels to strokes
• express the intermediate vowels & their places
• state the position of outline and intervening vowels.
Vowels - Definition
"If the mouth passage is left so open as not to cause audible friction, and voiced breath is sent through it, we have a
vowel" (Prof. Sweet).
Vowels are the soul of the language without which language cannot be used. Therefore, 12 vowels have been adopted in
English shorthand according to their sounds.
Vowel Sounds: There are six long vowel sounds and six corresponding short vowel sounds in English shorthand. The
long vowels may be remembered by repeating the sentence "Pa may we all go too". The short vowels may be remembered by repeating the sentence "That pen is not much good".
Vowel Signs: The long vowels are represented by a heavy dot and a heavy dash. The short vowels are represented by
a light dot and a light dash.
Vowel places: There are three points on a stroke in which a vowel sign may be placed, namely, at the beginning, in the
middle and at the end. The vowels are accordingly called first place, second place and third place vowels.
Example

Heavy Vowels
Dot •

Dash

Ist place

ah •

aw

IInd place

a •

o

III rd place

e

oo

•

"Pa may we all go too".

-

Light Vowels

-

Dot
∪
a
∪
e
∪
i

•

•

•

•

Dash ∪
o
∪
u

-

∪
oo -

"That pen is not much good".

Preceding & Following Vowels
If a vowel sign is written on the left hand side of an upstroke or down stroke, it is read before the stroke, as in

If a vowel sign is written on the right side of an upstroke or downstroke, it is read after the stroke, as in

If a vowel sign is written above a horizontal stroke, it is read before the stroke, as in

If vowel sign is written below a horizontal stroke, it is read after the stroke, as in

Copyright @ NIMI Not to be Republished
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Position of outline
Just as there are three places in which vowel signs are put, there are three positions of shorthand outlines of the words.
The first position of shorthand outline is above the line, the second position is on the line, and the third position is through
the line. The first sounded vowel in the word determines the position of the outline, as in

Intervening Vowels: First and Second place vowels, when occurring between two strokes are written after the first stroke,

but the third place vowel signs are written before the second stroke at the end, because the vowel sign is more conveniently written in that place.

8
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.1.04
Secretarial Practice (English) - Shorthand practice and windows operation system
Computer Fundamentals: Introduction, Definition, Utility, Types and
applications
Objectives: At the end of this lesson you shall be able to
• describe the various components of a computer
• distinguish between hardware and software
• describe applications of computer (IECT)
• explain how to connect accessories to computer.
Introduction
A computer is an electronic, digital device used to process
data, converting the data into information that is useful to
people/users. A computer system consists of hardware
and software components.
Hardware is the physical equipment such as the case,
storage drives, keyboards, monitors, cables, speakers,
and printers.
Software is the operating system and programs.

The operating system instructs the computer how to
operate.
Programs or applications perform different functions.
Information Processing Cycle (Fig 1)
•

Input

•

Processing

•

Output

•

Storage

Fig 1
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Application of computer

Travel

Word processing

•

•

Word Processing software automatically corrects
spelling and grammar mistakes.

•

The copy and paste features repeats the content of
the document

•

Printout documents and make several copies.

•

Images can be added to your document.

Internet
•

A network of almost all the computers in the world, we
can browse through much more information than you
could do in a library.

•

Because computers can store enormous amounts of
information.

•

Very fast and convenient access to information.

•

E-Mail you can communicate with a person sitting
thousands of miles away in seconds.

•

Chat software that enables one to chat with another
person on a real-time basis.

•

Video conferencing tools are becoming readily available
to the common man.

Digital video or audio composition
•

Audio or video composition and editing have been made
much easier by computers.

•

The Graphics engineers use computers to generate
short or full-length films or even to create threedimensional models.

•

Special effects in science fiction and action movies
are created using computers.

Desktop publishing
•

In desktop publishing, we can create page layouts for
entire books on the personal computer.

Computers in medicine

We can book air tickets or railway tickets and make
hotel reservations online. So time is saved.

Telecommunications
•

All mobile phones have software embedded in them for
maintaining customer details and also to send
messages, audio and video through the mobile software.

Defence
•

Software embedded in almost every weapon.

•

Software is used for controlling the flight and targeting
in ballistic missiles.

•

Software is used to control access to atomic bombs.

E-Learning
•

It is easier to learn from E-learning software. It not only
contains text but contains image and animation

Gambling
•

One can gamble online instead of going to a casino.

Examinations
•

One can write online exams and get instant results.

Computers in business
•

Shops and supermarkets use software, which calculate
the bills. Taxes can be calculated and paid online.

•

Accounting is done using computers. One can predict
future trends of business using artificial intelligence
software. Software is used in major stock markets.
One can do trading online. There are fully automated
factories running on software.

Certificates
•

Different types of certificates can be generated.

ATM machines
•

The computer software authenticates the user and
dispenses cash.

Marriage

•

Computer can diagnose diseases. We can learn the
cures.

•

Software is used in magnetic resonance imaging to
examine the internal organs of the human body.

News

•

Software is used for performing surgery.

•

•

Computers are used to store patient data.

Mathematical calculations
•

Large calculations are made easy in computer

Banks
•

All financial transactions are done by computer
software.

•

They provide security, speed and convenience.

10

•

There are matrimonial sites through which one can
search for a suitable groom or bride.
There are many websites through which you can read
the latest or old news.

Classmates
•

There are many alumni websites through which you
can regain contact with your classmates.

Robotics
•

Robots are controlled by software.

Washing Machines
•

Operate using software.
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Microwave Ovens

Weather analysis

•

•

They are operated by software.

Planning and Scheduling
•

Software can be used to store contact information, for
generating plans, scheduling appointments and
deadlines.

Supercomputers are used to analyse and predict
weather.

Components of computer
Input devices (Fig 2)

Plagiarism

Input devices used to enter data or instructions into a
computer

•

•

Keyboard

Greeting cards

•

Mouse

•

•

Digital camera

•

Scanner

•

Mic

•

Bar code reader

•

Joystick

Software can examine content for plagiarism.
We can send and receive greetings pertaining to
different occasions.

Sports
•

Software is used for making umpiring decisions. There
are simulation softwares using which a sportsperson
can practice his skills. Computers also identify flaws
in technique.

Aeroplanes
•

Pilots are trained on software, which simulates flying.
Fig 2

MOUSE

KEYBOARD

BARCODE READER

SCANNER

JOYSTICK

CAMERA

MIC
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Computer
Hardware
Definition & Introduction, Motherboard, Processor, Input & Output Devices and Storage Devices
Software: Definition & types of Software.

•

Double-clicking - Press and release the left mouse
button twice.

Keyboard Standard Layout (Fig 3)
•

A standard computer keyboard has about 100 keys.

•

•

Most keyboards use the QWERTY layout, named for
the first six keys in the top row of letters.

Dragging - Hold down the left mouse button as you
move the pointer.

•

Right-clicking - Press and release the right mouse
button.

Fig 3

Output Devices (Fig 5)

Mouse (Fig 4)
•

The mouse is a pointing device. You use it to move a
graphical pointer on the screen.

•

The mouse can be used to issue commands, draw,
and perform other types of input tasks.
Fig 4

•

Printers, Scanners, and Fax Machines - Printers are
output devices that create hard copies of computer files.
Other all-in-one type printers are designed to provide
multiple services such as printing, fax, and copier
functions.

•

Speakers and headphones are output devices for audio
signals.

Most computers have audio support either integrated into
the motherboard or on an adapter card. Audio support
includes ports that allow input and output of audio signals.
•

Visual display unit (Monitor, Screen etc.)

•

Printer/Plotter

•

Multimedia projector

•

Speaker

Printers
Impact printers
•

Dot matrix printers

Nonimpact printers
•

Ink jet

•

Laser

Monitors
Using the mouse involves five techniques
•

Pointing - Move the mouse to move the on-screen
pointer.

•

Clicking- Press and release the left mouse button once.

12

The most important difference between these monitor types
is the technology used to create an image:
•

Cathode-ray tube (CRT) monitor is the most common
monitor type. Most televisions also use this technology.

•

Liquid crystal display (LCD) is commonly used in
laptops and some projectors. LCD comes in two forms,
active matrix and passive matrix.
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Fig 5

MONITOR

PROJECTOR

PLOTTER

SPEAKER

PRINTER

CRT (Cathode Ray Tube) (Fig 6)

LCD (Liquid Crystal Display) (Fig 7)

1 Most inexpensive monitor.

1 Also known as flat screen monitors. But with its
proliferation, prices are continuing to drop.

2 It has a quite a large case.
3 Pixels, made up of phosphors, are the tiny components
that make up the image shown onscreen.
4 These pixels are struck by electrons, which make the
pixels glow and eventually form the desired image on
the screen.
Fig 6

2 LCD technology reduces blurring and colour smudging
during motion pictures, which makes this type of monitor
appropriate for gamers or film enthusiasts.
3 Requires less space and energy.
4 The display is far superior than the CRT monitors.
Fig 7
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Storage Devices (Fig 8)
Fig 8

FLOPPY DISK DRIVE

HARD DISK DRIVE

VIDEO TAPE

USB FLASH DRIVE

MEMORY CARD

DVD / CD

Floppy Disks

Central Processing Unit (CPU) (Fig 9)

•

CDs-Compact Discs

The computer CPU is responsible for handling all
instructions it receives from hardware and software running
on the computer. In the CPU, the primary components are
the ALU (Arithmetic Logic Unit) that performs
mathematical, logical, and decision operations and the
CU (Control Unit) that directs all of the processor’s
operations

•

Available in a variety of formats-CD-ROM, CD-R, CDRW

There are different brands and speeds

•

A typical CD holds about 700 MB of data

3.5-inch disks store 1.44MB of data

Hard Disks
•

Spins at 5,400 - 7,200 rpm.

•

Can store anywhere between GB to TB of data.

DVD's
•

Available as DVD-ROM, DVD-R, DVD-RW

•

Can hold 4.7 GB of data (standard)

USB Flash Drive
•

14

Storage capacity between MB - GB

•

Pentium made by Intel

•

Celeron made by Intel

•

Athlon made by AMD

•

Memory

•

RAM-also called Random Access Memory

•

ROM- also called Read Only Memory
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Fig 9

FRONT VIEW

BACK VIEW

Random Access Memory (RAM)

Processors & Memory (Fig 10)

•

Temporary storage for data and programs that are being
accessed by the CPU

Data Representation

•

Volatile memory, which means that the contents are
erased when the computer is powered off

•

More RAM means more capacity to hold and process
large programs and files, as well as enhanced system
performance.

Types of RAM
•

Dynamic Random Access Memory (DRAM)

•

Static Random Access Memory (SRAM)

•

Fast Page Mode DRAM (FPM Memory)

•

Extended Data Out RAM (EDO Memory)

•

Synchronous DRAM (SDRAM)

•

Double Data Rate SDRAM (DDR SDRAM)

•

Double Data Rate 2 SDRAM (DDR2 SDRAM)

•

RAMBus DRAM (RDRAM)

•

Byte-one character of data (8 bit)

•

1 Kilobyte (KB) =1024 Bytes

•

1 Megabyte (MB)=1024 Kilobytes

•

1 Gigabyte (GB)=1024 Megabytes

•

1 Terabyte (TB)=1024 Gigabytes

Read Only Memory (ROM)
•

Basic instructions for booting the computer and loading
the operating system are stored in ROM.
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Fig 10

ROM types

ROM types

Description

ROM

Read-only memory chips

Information is written to a ROM chip when it is
manufactured. A ROM chip cannot be erased or
re-written and can become obsolete.

PROM

Programmable read-only memory

Information is written to a PROM chip after it is
manufactured. A PROM chip cannot be erased or
re-written.

EPROM

Erasable programmable read-only
memory

Information is written to an EPROM chip after it is
manufactured. An EPROM chip can be erased
with exposure to UV light. Special equipment is
required.

EEPROM

Electrically erasable programmable
read-only

Information is written to an EEPROM chip after it
is manufactured. EEPROM chips are also called
Flash ROMs. An EEPROM chip can be erased
and re-written without having to remove the chip
from the computer.

Power Supply (Fig 11)

Fig 11

The computer gets its power from the external power
supply to system through SMPS (Fig.11) (Switch Mode
Power Supply) which acts as a AC to DC converter and
step down the volts to 3 - 12 DC. The external power card
is to be connected to the power supply plug in system
and the power supply on/off switch is switched on and the
power switch in the front side of the system is also
switched on then the power supply fan must run. If it is not
running then there may be a problem of power supply, if it
runs properly then we can assure that we got power to our
system.

16
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Motherboard

The motherboard serves as a single platform to connect
all of the parts of a computer together. It connects the
CPU, memory, hard drives, optical drives, video card, sound
card, and other ports and expansion cards directly or via
cables. It can be considered as the backbone of a computer.
Features of Motherboard
A motherboard comes with following features
• Motherboard varies greatly in supporting various types
of components.

• Motherboard supports a single type of CPU and few
types of memories.

• Video cards, hard disks, sound cards have to be compatible with the motherboard to function properly.

• Motherboards, cases, and power supplies must be com-

The motherboard is mounted inside the case and is securely attached via small screws through pre-drilled holes.
Motherboard contains ports to connect all of the internal
components. It provides a single socket for CPU, whereas
for memory, normally one or more slots are available.
Motherboards provide ports to attach the floppy drive,
harddrive, and optical drives via ribbon cables. Motherboard
carries fans and a special port designed for power supply.
There is a peripheral card slot in front of the motherboard
using which video cards, sound cards, and other expansion cards can be connected to the motherboard. On the
left side, motherboards carry a number of ports to connect the monitor, printer, mouse, keyboard, speaker, and
network cables. Mother boards also provide USB ports,
which allow compatible devices to be connected in plugin/plug-out fashion. For example, pen drive, digital cameras, etc.

patible to work properly together.

• Description of Motherboard
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Different types of software

Common Utility Programs

Key difference

These programs are designed specifically for managing
the computer device and its resources. It includes programs like communication tools and disk formatter. They
are more focused on the operations of computer infrastructure. For example - Virus scanner is a kind of common
utility programs which provides protection to the system
from unwanted guests like Trojans and viruses.

Software refers to a set of programs which is capable of
performing some specific tasks on a computer system.
They can be broadly classified into two categories - System software and Application software.

Application Software
System softwares are more concerned about the background programs of the computer system. However, an
application software performs some specific task on a
system. There are numerous types of application software. They deal mainly with solving out some specific
computing types of problems. They work for fulfillment of
specific needs only. These types of software are also known
as apps in short. Some of the common application software are.
Software refers to computer programs which perform specific functions as instructed. It can be a single program
or may refer to a number of programs collectively. These
instructions are defined in proper step by step manner. It
is important to mention that hardware becomes incapable
for extending its capabilities without support of the software. These software programs assist computer and network to start and work.
Softwares are broadly classified into two categories
System Software
This software is usually engaged in background processes.
This software sync the work of hardware and other types
of programs. It acts as a middle layer between hardware
and user applications. System software includes programs like
Operating System
It is a well - known example of system software. This
software interacts with the hardware and provides the capability for running various types of programs. Desktop
uses operating systems like Window, Linux and MacOS,
whereas Android and Windows are commonly used operating systems for mobiles. There are different types of
operating systems like real time, distribute, embedded,
etc., It is necessary to consider the hardware specifications before deciding the operating system.
Language translators - It includes assemblers, compilers
and interpreters. These programs have been designed for
programming languages like C, Cobol, Pascal, etc. Machine Language is translated into machine code with the
help of an assembler. Compiler translates the code written in a high level language to a lower one. An interpreter
is capable of executing programs directly. It executes
the program in a line by line manner.
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Word processors
These softwares programs are used for creation of documents. In addition to basic activity of creating a document, it also assists in storing and printing that document. Changes can be easily made in the document
through these word processors. It is one of the most commonly used application software. MS - Word is an example of a word processor program.
Database software
This software is capable of creating databases. In addition to it, it also manages the data or information residing
inside the database. It is also known as DBMS sometimes. They help in organizing data. Some of the examples
of database software are Access, Oracle and Sysbase.
Multimedia software
These softwares have been devised to work with different
types of media which are connected with each other, they
are usually used in multimedia presentation.
Education and reference software
These softwares have been devised in order to assist in
learning about any specific thing. There are many different
types of tutorial software programs which fall under this
category. Many of these software programs have been
designed for children for assisting them in their learning.
They are also known as academic software. Ultimate Maths
invaders and My Amazing Human body are two such
softwares.
Graphic software
These software programs assist in working with graphics,
as they enable the user to edit or manipulate visual images. It includes image editors and illustration software.
Adobe Photoshop and Corel Photo paint are two popular
examples of graphic software. These types of software
usually work on either bitmap or vector images.
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Web browser

Examples and types of software

This is a software program which is used for locating and
retrieving files or resources on the World Wide Web.
Internet explorer like web browser comes integrated with
the operating system. Mozilla FireFox is another example
of an application software program. It is an open source
and Multi - Platform Software.

Below is a list of the different kinds of software a computer may have installed with examples of related programs. Click any of the links below for additional information.

There are many other types of application software programs like - enterprise software, spreadsheet software,
information worker software, simulation software, games,
etc.
Software

It should be noted that although software is thought of as
a program, it can be anything that runs on a computer.
The table below also includes a program column to clarify
any software that is not a program.

Examples

Program

Antivirus

AVG, Housecall, McAfee, Norton

Yes

Audio/Music Program

iTunes, WinAmp

Yes

Database

Access, MySQL, SQL

Yes

Device drivers

Computer Drivers

No

E - Mail

Outlook, Thunderbird

Yes

Game

Madden NFL Football, Quake, World of Warcraft

Yes

Internet browser

Firefox, Google Chrome, Internet Explorer

Yes

Movie Player

VLC, Windows Media Player

Yes

Operating System

Android, iOS, Linux, macOS, Windows

No

Photo/Graphic Program

Adobe Photoshop, CorelDRAW

Yes

Presentation

Powerpoint

Yes

Programming Language

C++, HTML, Java, Perl, Visual Basic (VB)

Yes
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.1.05
Secretarial Practice (English) - Shorthand practice and windows operation system
Short forms: Logograms, Grammalogues & Contractions, Use of tick ‘The’
in phrasing, Use of Punctuation Marks
Objectives: At the end of this lesson, you shall be able to
• state the logograms
• define the grammalogues
• define contractions
• explain phrasing and TICK ‘THE’
• put punctuation marks in shorthand.
Short forms
For the purpose of quick and easy writing frequently occurring words are represented by small signs in shorthand called
short forms. These can be divided into three categories, i.e., Logograms, Grammalogues and Contractions.
1 Logogram: A frequently occurring word represented by a small imaginary sign in shorthand is called a logogram.
There are only 24 logograms formed by dots, dashes, angular signs, circles and loops in English shorthand as
a/an,

the,

all,

and, etc.,

2 Grammalogues: A frequently occurring word represented by a single consonant stroke in shorthand is called a
grammalogue as

can,

give/given,

Any/in

put, etc.,

3 Contraction: A frequently occurring word represented by two or more consonantal strokes is called a contraction.
Simple contractions can be formed by joining / disjoining strokes to the grammalogues, thus,
being,

going,

income,

because, etc.

4 Phrasing: Writing of two or more words or short forms without lifting the pen is called phrasing, thus

to do,

should be, etc.,
5 Tick 'the': The word 'the' is frequently used in English and may be represented by a light slanting tick, joined after
a stroke or short form of words and written in opposite direction of stroke as
on the,

of the ,

at the, etc.,

Punctuation Marks in Shorthand
Punctuation Mark
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Sign

Shorthand Sign

Full Stop

.

x

Comma
Semi-colon

,
;

,
x
,

Colon

:

x
x

Hyphen

-

=

Dash

_

Exclamation

!

Question

?

Brackets

()

Paragraph

//

//

Proper nouns

Capital Letters

//
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.1.06
Secretarial Practice (English) - Shorthand practice and windows operation system
Computer Windows Operating System: Introduction, Log on accounts,
Passwords, Minimizing, Windows Resizing, Moving, Closing Windows,
Windows Menu, Tool Bar, Task Bar, Menu Bar and Start Button, Shutting
down Windows. Desktop, Windows Explorer, Control Buttons Open, Cut,
Copy and Paste, etc.
Objectives: At the end of this lesson you shall be able to
• explain Windows Operating System
• explain versions of Windows
• describe start button and its options
• explain how to manage desktop and its icons
• explain windows explorer
• describe the control panel and its various services.
The Windows Operating System
Every computer needs an operating system for operating
the computer. There are a few around and Microsoft
Windows is just one of them.
Some of the functions the Windows operating system
allows to do are:
• Access applications (programs) on the computer (word
processing, games, spread sheets, calculators and so
on)
• Load any new programs on to the computer
• Manage hardware such as printers, scanners, mike,
digital cameras
• Manage how files are stored on computer (File
Management covered later in this module)
• Change computer settings such as colour schemes,
screensavers, and the resolution of monitor.
There are several versions of Microsoft Windows in
existence. They are Windows XP, Windows Vista,
Windows 7 and Windows 10.

XP in that market. Windows 7 Starter has some features
disabled. There is no Windows Aero theme, Personalization features (such as changing the wallpaper) are not
available, and there is no support for multi-media features
such as Windows Media Centre.
Windows 7 Home Premium is considered the least
expensive full version of Windows 7 and it is the least
expensive version one can buy at a retailer. Windows 7
Professional is an upgrade that includes some useful
utilities that both home and business users can appreciate.
Windows 7 Ultimate has advanced security and language
features.
The START button
The START button is located at the bottom of the screen
on the left-hand side of the taskbar and has access to
most things available on the computer. When clicked on
the START button the following can be accessed (Fig 2).
Fig 2

Windows versions
Windows 7 continues the Microsoft tradition of releasing
different versions of Windows for different users. There are
four versions of Windows 7 available - Starter, Home Premium, Professional and Ultimate (Fig 1).
Fig 1

Windows 7 Starter can't be purchased at retail. It is meant
primarily for net books and is a replacement to Windows
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Documents: The DOCUMENTS menu links to default
saving location.

•

Display detailed information about the devices, such
as make, model, and manufacturer

Pictures: This will link for pictures folder

•

See what tasks one can do with a particular device.

Music: This links to a folder for storing music

Search programs and files: Allows to search for files,
folders, printers, software applications, etc. by entering
search criteria

Computer: Clicking this link will show the drives connected
to this computer
Control Panel: Allows making changes to the current
settings on the computer.
Devices and Printers: The Devices and Printers folder
displays devices connected externally to the computer,
including devices connected wirelessly or over the network.
The Devices and Printers folder allows to performing many
tasks, which vary depending on the device. Here are the
main tasks it can do:
•

View all the external devices and printers connected
to the computer.

•

Add a new device or printer to the computer.

•

Check to see if a specific device is connected and
working properly

Help and Support: Access to a help facility where one
can find out how to do certain things on the computer.
Log Off: Allows you to log off as a User without turning off
the computer. This would allow someone else to log on.
Desktop in Windows 7
The desktop (Fig 3) is the main screen area that one will
see after Turn On the computer and Log On to Windows.
Like the top of an actual desk, it serves as a surface for
the work. When one opens programs or folders, they appear
on the desktop. And one can also put things on the
desktop, such as files and folders, and arrange them.
The desktop is sometimes defined more broadly to include
the taskbar. The taskbar sits at the bottom of the screen.
It shows which programs are running and allows switching
between them. It also contains the Start button

, which

can be used to access programs, folders, and computer
settings.
Fig 3

Glossary of Desktop Icons
My Documents
MY DOCUMENTS is the default storage folder for the files
to create. When you want to save or open a file, Microsoft
Windows initiallyopens the MY DOCUMENTS dialog box.
22

My Computer
MY COMPUTER displays information about the computer,
such as the contents of the computer drives and which
printers have installed. It also allows finding, viewing and
organising files.
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The Recycle Bin

Fig 4

The computers data files should be tidied up regularly and
any unwanted files deleted from the system. Any file deleted
from the hard drive will be placed first in the RECYCLE
BIN.
Internet Explorer
With INTERNET EXPLORER and Internet connection we
can search and view the information on the World Wide
Web. It is used to search the Internet for people,
businesses and information about subjects, download
music, copy graphics, stay in touch with or meet new
friends and a host of other activities.
Working with desktop icons
Icons are small pictures that represent files, folders,
programs and other items. Windows, has at least one
icon on the desktop and starts the Recycle Bin (more on
that later). The computer manufacturer might have added
other icons to the desktop.

Selecting multiple icons
To move or delete a bunch of icons at once, you must first
select all of them. Click an empty area of the desktop and
drag the mouse. Surround the icons to select with the
rectangle that appears (Fig 5). Then release the mouse
button. Drag the icons as a group or delete them.
Fig 5

Adding and removing icons from the desktop
You can choose which icons appear on the desktop-you
can add or remove an icon at any time. Some people like
a clean, uncluttered desktop with few or no icons. Others
place dozens of icons on their desktop to give them quick
access to frequently used programs, files, and folders.
User can easily access from the desktop to the favourite
files or programs, and can create shortcuts to them. A
shortcut is an icon that represents a link to an item, rather
than the item itself. When double-click a shortcut, the
item opens. If you delete a shortcut, only the shortcut is
removed, not the original item. Identification of shortcut is
by the arrow on the icon (Fig 4).

Taskbar History
The first thing that one notices when using Windows 7 is
that the Windows taskbar (Fig 6) has been given its first
major revision since Windows 95. Instead of using boxes
with text and an icon to indicate an open task, the new
taskbar uses icons only. The taskbar also no longer shows
every single task that is open - instead, tasks are grouped
by program, and all instances of an open program are
displayed by hovering over a program's icon.

Fig 6

Windows Explorer (Fig 7)

Windows 7 Control Panel (Fig 9)

Windows Explorer has become a very powerful utility for
navigation and searching directories for files in the system.
The field at the top is used to contain an address like
C:\Documents and Settings\Directory. This address is now
much more functional.

The Control Panel in Windows 7 is the place to go when
one needs to make changes to various settings of the
computer system, to control most Windows commands
and features using the various options and sliders in the
Control Panel.

Windows Search (Fig 8)

To open the Control Panel, click the Start button on the
taskbar and then click Control Panel on the Start menu.
Windows 7 gives three different views for looking at the
computer's Control Panel: To switch views, click the View
by drop-down button (labelled Category by default) in the
upper-right corner of the Control Panel and then choose
one of the views from the button's drop-down menu.

Windows helps to search the files from any directory. It
just navigates to the folder and initiates search from the
search field in the upper-right corner of the window. Next,
Windows Explorer now gives the ability to preview
documents as select them from search results. This is an
option which can be enabled and disabled on the right
side of the Menu Toolbar.
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Fig 7

Fig 8
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Fig 9

Category view (Fig 10)
By default, the Control Panel is displayed in Category
view, which is separated into eight categories, ranging from
System and Security to Ease of Access. To open a window

with the Control Panel options for any one of these
categories, simply click the category's hyperlink.

Fig 10
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Some Important Tools of Controls panel

Internet Options

Administrative Tools

Allows to change the Internet Settings - Settings such as
Security, Privacy, Content, History, Connections and so
on. This control panel is for Very Advanced Users only.

This control panel is for Very Advanced Users only. It allows
Partitioning a Hard Drive, Stop/Start System Services,
Schedule System Tasks, Manage Windows Firewall
Settings and so on.
Backup and Restore Center
Allows to back up (and then restore) Picture files, Music
files, Videos files, E-Mails, Documents, Windows Media
Center, Recorded TV Shows and Compressed files either
as a custom backup or as part of a full (hard drive image)
backup. System files, Program/Executable files and
temporary files will also be backed up alongside the own
personal data files.
Date and Time
As well as for the obvious changing of the Data and Time
this control panel also allows to change the Time Zone
(i.e. to Hong Kong), synchronize the time with a time server
(internet clock) and have two additional times (clocks) as
part of the notification area clock.

Keyboard
Allows to change the speed of the keyboard and the speed
of the flashing cursor.
Mouse
Allows to change Mouse and Mouse Pointer settings. For
example one can change the look of the mouse pointer,
the speed of the mouse, whether or not the mouse is lefthanded or right-handed, the number of lines scrolled when
using a wheel mouse and so on.
Network and Sharing Centre
Manages the Network side of Windows 7.setup and then
connects to a network, checks a network's status, changes
network settings and sets preferences for sharing files
and printers amongst other things.
This control panel is for Very Advanced Users only.

Device Manager

Sound

Allows to Install or uninstall the driver software for a
particular piece of hardware. Device Manager is good if a
piece of hardware is not working correctly and needs to
be uninstalled. Or when a piece of hardware cannot be
installed because no Installation CD for it, that contains
its driver software, and therefore need to check the Internet
for its driver software. Even if the hardware is working fine
sometimes you might want to disable the hardware, for
whatever reason(s) - Device Manager allows you to Enable
or Disable hardware as well.

Allows to configure the Sound and Audio Devices (Sound
Themes, Volume and so on).

Devices Printer
Allows to set the default Printer, adjust Keyboard and
Mouse properties, control Windows Fax And Scan software
as well as view/control other aspects of the hardware (i.e.
the computer and a flash drive).

Taskbar and Start Menu
Allows to configure the Taskbar and Start Menu settings Their appearance mainly.
User Accounts
Allows to configure the User Accounts, their Rights,
password, picture and so on.This control panel is for Very
Advanced Users only.
Windows Firewall
Allows to configure Windows 7's, built-in, Firewall settings.
This control panel is for Advanced Users only.

Display
Allows to adjust certain aspects of the display screen,
such as its Resolution (Desktop Size), its Clear Type (Font
Readability), Text Size, Brightness and so on.
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.1.07
Secretarial Practice (English) - Shorthand practice and windows operation system
Diphthongs: Definition, Signs and Places of Diphthongs and Triphones
Objectives: At the end of this lesson you shall be able to
• explain a diphthong
• describe diphthong signs and their places
• state triphonic signs and their places.
Definition
Numerous definitions of Diphthongs are given in English
language. Without going into the linguistic controversies,
for Shorthand writing, a Diphthong can be defined as "a
union of two vowel-sounds" by (Daniel Jones), as in tie,
lie, by, my, cow, type, boil, guide, duty, beauty, etc. In
shorthand (phonetic) writing the actual presence of twovowels is not necessary. In words like by, how, shy, my,
boy, etc., though a diphthongal (two vowel) sound occurs,
the actual occurrence of two vowels is absent.

Similarly, in words like maid, aim, she, zoo, see, keep,
meal, load, Paul, etc. though two vowels actually occur
the two-vowel (diphthongal) sound is absent. These are
thus written in Shorthand by long vowels according to their
sounds about which we have already learnt.
Diphthongs and their places: There are 4 common diphthongs, i, ow, oi and u as heard in the sentence “I now
enjoy music”.

The formation of diphthongs are shown below

Sound l-1st place
Sound ow
ow-3rd place
Sound oi
oi-1st place
sound u-3rd place
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DIPHTHONG ‘I’:
The diphthong ‘I’ is written in the first place; as in
pipe,

pike,

right,

tire,

fire

The diphthong ‘I’ is joined initially to downstrokes and N; thus,
eye-ball,

item,

idle,

ice,

I-know.

The abbreviated form of ‘I’ i.e. the first tick may be joined initially to
upward L and M; thus,
isle,

I’m

The diphthong ‘I’ may be joined finally to N; thus

Nigh,

deny

DIPHTHONG ‘OW’:
The diphthong ‘OW’ is written in the third-place.
Ouch,

couch,

mouth,

loud,

county.

Initially and finally it is joined to other consonants
Initially ‘OW’ is attached to upward L; thus,

owl.

Finally, ‘OW’ is joined to downstrokes, when convenient; thus,
bow,

vow,

sow,

anyhow.

The diphthong ‘OW’ may be abbreviated when attached to N; as in
now.
DIPHTHONG ‘OI’
The diphthong ‘OI’ is a first place diphthong and is always written
at the beginning of the consonant; thus
boy,

joy,

boiling,

toil,

coil.

It is always joined initially to upward L; thus,
oil,

28

oiling,

oilship.
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DIPHTHONG ‘U’.
Diphthong ‘U’ is a third-place diphthong and must always be written
at the end of the stroke. It may be joined to downstrokes; thus,
pew,

due,

few,

Mathew,

issue.

It is joined finally to k, g, m, n, l by slightly changing the angle for
convenience in joining; thus,
kew,

argue,

mew,

value,

renew.

TRIPHONES
The TRIPHONE (tri = three + phone = sound) is a three vowel sound i.e. diphthong + any vowel. The triphone is
represented by adding a tick to the relevant diphthong sign; thus,
dire, but
towl, but
boy, but
due, but

diary,
towel,

dialogue,
tower,

viola
power

buoyant,

boyish,

loyal

dual,

tenuous,

duet.
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.1.08
Secretarial Practice (English) - Shorthand practice and windows operation system
Computer keyboard functions
Objectives: At the end of this lesson you shall be able to
• escape key
• function keys
• tab key
• alphanumeric keys
• Ctrl, Alt, and Shift
• arrow Keys
• numeric keypad.

The Escape (ESc) key allows you to stop a function
or action
Ctrl + C or Ctrl + Insert
Both Ctrl + C and Ctrl + Insert copy the highlighted text
or selected item.
Ctrl + F

Ctrl + Z and Ctrl + Y
Ctrl+Z will undo any change. For example, if you cut out
some text, this shortcut will undo it. This can also be
pressed multiple times to undo multiple changes. Pressing Ctrl + Y would redo the undo.
Alt + Tab or Ctrl + Tab

Pressing Ctrl + F opens the "Find" in any program. This
includes your internet browser to find text on the current
page. For instance if you want to find a person's name in
a registry this shortcut would be a fast way to do that.

This allows you to quickly switch between open programs
moving forward.

Ctrl + P

Tip: If you also add in the Shift key to Alt + Tab or Ctrl +
Tab it will move backwards. For example, if you are pressing Alt + Tab and pass the program you want to switch to,
press Alt + Shift + Tab to move backwards to that program.

Open a print preview of the current page or document being viewed. For example, press Ctrl + P now to view a
print preview of this page.
Ctrl + S
While working on a document or other file in almost every
program pressing Ctrl + S saves that file. This shortcut
key should be used frequently anytime you're working on
anything important.
Ctrl + V or Shift + Insert
Both the Ctrl + V and Shift + Insert paste the text or
object that's in the clipboard.
30

Tip: Press Ctrl + Tab to switch between tabs in a program such as your internet browser.

Tip: Windows Vista and 7 Users can also press the Windows Key + Tab to switch through open programs in a
full screenshot of the Window.
Ctrl + Back space and Ctrl + Left or Right arrow
Pressing Ctrl + Backspace will delete a full word at a
time instead of only a single character.
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Hold down the Ctrl key while pressing the left or right
arrow to move the cursor one word at a time instead of
one character at a time. If you wanted to highlight one
word at a time you can hold down Ctrl + Shift and then
press the left or right arrowkey to move one word at a
time in that direction while

Function Keys

Ctrl + Home or Ctrl + End

• Arrow Keys

Ctrl + Home will move the cursor to the beginning of the
document and Ctrl + End will move the cursor to the end
of a document.

• Numeric Keypad

Page up, Space bar, and Page Down
Press either the page up or page down key to move
that page one page at a time in that direction. When browsing the internet pressing the space bar also moves the
page down one page at a time.
Computer key board operations
Keyboard

• Tab key
• Alphanumeric Keys
• Ctrl, Alt, and Shift

There are different types of keys on the keyboard. The
keys are categorised as:

• Alphanumeric Keys, including letters and numbers.
• Punctuation Keys, Such as the colon(:), the semico-

lon (;) the question mark (?), single quotes (‘) and double
quotes (“).

• Special keys, such as Arrow keys, control keys and
Function keys (F1 to F12)

The keyboard (Fig.1) is used for typing text into the computer. It is also known as the standard input device. A
computer keyboard is similar to that of a typewriter, but it
has additional keys as well. The most commonly available computer keyboard has 104 keys.
Key Board
Print Screen, Scroll Lock, Pause/Break. The print Screen,
Scroll Lock, and Pause/Break keys are at the top - right
corner of the keyboard.

These keys have different functions depending on where
they are used. For example, the ENTER key starts a
new paragraph in a word processor, but in the command line, it executes a command.
Function keys are special keys that are used to perform
specific functions. They are labelled as F1, F2, F3 and so
on, up to F12. The functionality of the keys differs from
software to software. The function of the F1 key in most
software is to provide help with the software.

• Escape key. The Eacape (Esc) Key allows you to stop
a function or action.
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.2.01
Secretarial Practice (English) - Formation of words, phrases and practice of MS word
Alternative forms of R & H Strokes
Objectives: At the end of this lesson you shall be able to
• define the alternative forms for R & H
• illustrate thickened LR/RR
• state when LR and RR are not used.
Downward R & H
Alternative forms For ‘R’ And ‘H’
Consonant ‘R’
The Liquid consonant ’r’ is the most frequently occuring consonant in English language. It is provided with two alternative forms; one is downward

and the other is upward

.These two forms are provided for easy joining with other

strokes and also to indicate the occurrence of initial or final vowel sound.
When preceded by a vowel, initial ‘r’ is written downward; thus,

When not preceded by a vowel, upward ‘R’ is written; thus,

Generally,initial or final ‘r’ is written upward when followed by vowel; thus,

Initial or final ‘r’ is written downward when not followed by vowel; thus,

Before ‘m’, initial ‘r’ is always written downward for easier joining; thus,

CONSONANT ‘H’
The consonant ‘h’ is also provided with two alternative forms – upward

and

downward .

The upward form of ‘h’ is generally employed; thus

32
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The downward form is used when ‘h’ is standing alone or when it is immediately followed by ‘k’ or ‘g’; thus,

Thickened LR/RR

The downward ‘l’ is thickened for the addition of ‘r’ and thereby represents the compound consonant of ‘lr’. The vowel
between ‘l’ and ‘r’ is generally unaccented. Short vowels ‘e’, ‘a’, ‘u’, etc. generally occur between ‘l’ and ‘r’( –lar, -ler, -lour),
thus,

A small circle can only be attached finally to the compound consonant ‘lr’; thus,
counsellors
When a strongly sounded vowel occurs between ‘l’ and ‘r’, strokes ‘l’ and ‘r’ are to be used;

When a vowel follows final ‘lr’, stroke ‘l’ and ‘r’ are to be used; thus,
foolery,
When ‘l’ is having an initial attachment like circle, loop, or hook, ‘lr’ is not used and strokes ‘l’ and ‘r’ are to be used;
thus,
After straight downstrokes of p, b, t, d, ch, j, k, g, s, m. l(up) ‘lr’ is written with strokes ‘l’ and ‘r’; thus,

After straight downstrokes, horizontals or upstrokes or right-hand curves with final circle, ‘lr’ is written with strokes ‘l’ and
‘r’; thus,

The downward ‘r’ is thickened for the addition of ‘r’ and thereby represents the compound consonant of ‘r+er’. The vowel
between ‘r’ and ‘r’ is restricted to the short vowel ‘e’. Hence, if any other vowel occurs between ‘r-r’, the compound
consonant of ‘rer’ is not used; thus,
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Initially, small circle ‘s’, large circle ‘sw’, small loop ‘st’, tick ‘h’ may be prefixed; thus,
Finally, small circle ‘s’ can only be added to the compound consonant ‘rer’; thus,

34
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.2.02
Secretarial Practice (English) - Formation of words, phrases and practice of MS word
Abbreviated W and Diphones
Objectives: At the end of this lesson you shall be able to
• explain the alternative forms of ‘w’
• explain diphones.
Alternative forms and their uses
•
•

Abbreviated W
Diphone

Abbreviated ‘w’
The consonant ‘w’ represented by initially hooked straight upstroke is also represented by an abbreviated form of right
semi circle. The initial sound of ‘w’ before ‘k’, ‘g’, ‘m’, ‘ray’, ‘ar’, is represented by the right semi-circle; thus,
Alternative forms and their use
a. Abbreviated W (Semi circle): The initial sound of W, is represented in many cases by semi-circles to obtain
clear outlines, Thus

but when initial sound of W is preceded by a vowel the stroke ‘w’ must be written, as in

b. A small hook is attached before L stroke to represent the initial W sound, as in

c. The semi-circle can also be used in the middle and in the end to represents W/V sounds wherever convenient,
as in

Diphones
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.2.03
Secretarial Practice (English) - Formation of words, phrases and practice of MS word
Aspirate H: Tick & Dot H, Downward & Upward stroke H, Upward & Downward stroke ‘SH’
Objectives: At the end of this lesson, you shall be able to
• explain the alternative forms of aspirate H
• state the TICK & DOT H & UPWARD SH
• describe phraseography.
Aspirate H
The consonant H is represented not only by the upward stroke but also by a downward form of H. Various forms of H have
been provided for easy and speedy writing in shorthand.
Downward ‘H’
The downward form of ‘h’ is used when standing alone; thus,
and derivative words, such as,

hewer,

hew,

highway,

high; and in the compound words

high-class.

Before ‘k’ ‘g’ ‘m’ ‘l (up)’ ‘r(down)’, downward form of ‘h’ is used;
thus,

hook,

hog,

hackney,

Higgins,

ahem.

After upward ‘l’ and horizontal strokes, ‘h’ is written downward;
thus,

Lahore,

cohere,

maharaja,

unhook.

In a few cases when ‘h’ occurs after curved strokes, the circle of ‘h’ is
written inside the curve; thus,

Sahara,

Sheehy.

In a few cases where ‘s’ and ‘h’ occur consecutively and medially, the circle is enlarged to represent ‘s’ and ‘h’; thus,
Fitzhugh,

race-horse.

In a few cases when ‘h’ occurs after another stroke, it is to be written in such a way that ‘h’ should
not be misread as ‘s-ch’ or ‘s-r’; thus,
compare

cohere but

ex chequer;

observer but

abhor .

Upward ‘H’
The upward form of ‘h’ is used in most of the cases, as it joins with other strokes and abbreviated
forms, more easily; thus,
hang,
hammer,
36

hurry ,

happy,
host,

behave,

head,
hisses,

hitch,
hiv e,

huge,
hen,

hash,
ha wker,

overhaul.
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honey,
heckle,

TICK ‘H’
Before ‘m’ ‘l’ and ‘r’, initial ‘h’ is represented by a small tick written in the direction of downward ‘h’; thus,
hell,

ham,

hare.

The tick ‘h’ may be used medially also in phraseography words); thus,
with-whom,

for-her,

to-her,

of-her

DOT ‘H’
In some cases where stroke ‘h’ cannot easily be written in the middle of a word, ‘h’ is represented by a light dot
before the vowel to which ‘h’ is attached; thus,
glasshouse,

manhood,

neighbourhood,

likelihood,

downhill,

uphill,

pinhole,
leasehold.

The dot ‘h’ is never used initially.
Upward and downward ‘SH’
‘sh’ when standing alone with or without initial or final attachment is written downward; thus,
ash,

ashes,

ocean,

shoe,

shoes,

usher

,

Swash,

shine,

ushers.

When attached to a straight stroke, ‘sh’ is generally written downward; thus,
sherry,

cherish,

rash,

shake.

When attached to straight downstroke with initial attachment, ‘sh’ is written on the opposite side of
the initial attachment; thus,
written upward; thus,

splash,

brus h,

blush, but after ‘d’ it is

dash.

When ‘sh’ is joined to a curve, it generally follows the motion of that curve; thus,

fresh,

a fresh.
‘Sh’ is written downward after ‘n’; thus,

gnash
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.2.04
Secretarial Practice (English) - Formation of words, phrases and practice of MS word
Phraseography - Formation of simple phrases
Objectives: At the end of this lesson, you shall be able to
• explain the importance of phrasegraphy
• state the rules of position writing.
Phraseography - Formation of Simple Phrases
Phraseography in shorthand is writing two or more words together, without lifting the pen. The resultant outline is
called phraseogram.

• You can write your own phrases subject to the following rules:
• The qualities of best phraseogram are facility, lineality and legibility.
• A phraseogram should neither ascend too far above the line, nor descend too far below the line, the reason being, if
the hand is carried too far away from writing line, it will take some time to come back to the writing line to take up
the next outline.

• A phrase must be easy to write.
The terms of facility, lineality and legibility are discussed below:
Facility: Phraseogram should be easy to write even in high speed.
Lineality: Phraseogram should not go up too far above the line of writing and should not go down too far below the
line of writing.
Legibility: Phraseogram should be easily readable at first sight.
The first word hould be written in its own position and the rest will follow it; thus,

how-can-they,

it-would-be,

-----------I-have-the.
When the first stroke in the phraseogram is of first place, the same may be slightly raised or lowered, so that the
second stroke can also be written in its own position for easy deciphering; thus,

I-thank-you,

with-much,

with-which, -------- with-each.
Before ‘k’, ‘m’, ‘l’(up) ‘I’ is written with a single tick; thus,
In phraseography

thus,

heshould-know,

‘much’ is written in full as
so-much,

or

they were,

I-will-be.
he-may,

if-he-should-know.
for easier joining and also to distinguish from ‘which’ and ‘each’;

how-much,

‘Were’ is represented by
were,

I-may-be,

‘he’ is represented by stroke initially, and by logogram medially; thus,

if-he-may,
In phrases,

I-can-be,

too-much.

whichever joins easily in phrases; thus,

you-were,

if-you-

if-they-were.

In phrases, the word ‘him’ is represented by inserting a dot vowel at third place, to distinguish it from ‘me’ ‘am’, ‘my’
etc.; thus,

of-him,

to-him.

Generally there is no need of vocalization (placing vowel signs) in phraseography.
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Phrases
I thank you

why have you

I think you should be

with you

I have the

too much

I have had

with much

I saw the

with which

I see

with each

I am

when they

I may be

what do you

I will

what was

I will be

what can be

you should

it would be

you should be

it should be

you can

it will be

you will

it was

you will be

which was

you may be

which were

you were

he should be

if you were

he will be

they were

if he

how can they

if he were

why do you

too much
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Special Phrases and Words
A group of words which makes sense, though not complete sense, is called a phrase. In addition to these, a number of
Verbal Phrases (idioms) Parliamentary, Executive, Judicial, Departmental and Foreign phrases (words) are also used in
English language, which have to be practised thoroughly for speed writing.
Verbal Phrases
All languages have certain expressions which are peculiar to them and lend special meaning to the words and phrases
known as idioms. English language is rich in such expressions. Thus idiomatic phrases are formed by the combination
of verbs, prepositions, adjectives, adverbs, nouns, etc., However, some important phrases given in this lesson will help
you realize their utility in the day to day working.
Phrases are of great help in Shorthand. Therefore, phrases should be short, simple and sure to enable speedy writing
reading and correct transcription.
Verbal Phrases (idioms)

40
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Parliamentary Phrases
S.No.

Words

1.

I would like to know

3.

I would like to submit

5.

My hon'ble friends

7.

In this House

9.

Human lives

11.

both Houses of Parliament

13.

To the best of their ability

15.

From time to time

17.

Inspite of the fact that

19.

In regard to the

21.

With regard to the

23.

Keep(ing) in view

25.

In view of

27.

on his behalf

29.

on their behalf

31.

Members of Parliament

33.

Ifs and buts

35.

Mr Deputy Speaker

Out lines

S.No.
2.

4.

Words

Out lines

I would like to state

Hon'ble Members of this House

6.

In the first instance

8.

Pointed out

10.

It will not be

12.

To the best of my ability

14.

To the best of your ability

16.

Come to the conclusion

18.

Having regard to the

20.

In relation to

22.

They were able to

24.

On account of

26.

On my behalf

28.

On your behalf

30.

Brought out

32.

Social and economic

34.

Honourable Minister

36.

In this connection
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Executive Phrases
S.No.

Words

Out lines

S. No.

Words

1.

From the point of view

2.

From my point of view

3.

In view of the circumstances

4.

Apart from the fact that the

5.

I should like to conclude

6.

In the course of the

7.

From the facts

8.

On the table

9.

Lok Sabha

10.

Rajya Sabha

11.

Will be taken into consideration

12.

Will be taken into account

13.

Will have to be considered

14.

Taken into consideration

15.

What has happened

16.

What is happening

17.

It would have been

18.

What would happen

19.

Balance sheet

20.

State of affairs

21.

Profit and loss

22.

Assets and liabilities

23.

Deficit financing

24.

Finance Minister

26.

Fiscal targets

25.

Fiscal policies

28.

Mr. Vice Chairman

27.

Mr. Deputy Chairman

30.

Let us try

29.

For a long time

32.

Has to be considered

31.

Special consideration

34.

For your consideration

33.

For consideration

36.

Shall be considered

35.

Under consideration

38.

Ought to be considered

37.

As a result of
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.2.05
Secretarial Practice (English) - Formation of words, phrases and practice of MS word
MS Word - Creation of File and use of various tools
Objectives: At the end of this lesson you shall be able to
• explain MS Word 2007
• define how to start MS Word 2007
• explain office button, quick access toolbar, tabs, and ribbon
• explain common tools in MS Word 2007
• state how to create, open, save and close the word document
• define editing text, table, mail merge, page layout, clip arts, picture, shapes, page numbering
• explain formatting text, styles, table, page layout, clip arts, picture, shapes
• explain change the text style in Word document.
Microsoft Office 2007

Microsoft Office Word 2007

Microsoft Office 2007 is a bundled application software
package introduced by Microsoft Corporation. Office 2007
has more features than the earlier version of office 2003.
Microsoft Office 2007 consists of the following popular
application packages:
•

Microsoft Office Word 2007

•

Microsoft Office Excel 2007

Microsoft Office Word 2007 is a word processor. A word
processor is a software package that helps to create and
edit a document. Word perfect, Word star, Write, Microsoft
word are the popular word processors. Now, Microsoft word
is the most popular word processor today. It helps you
produce professional-looking documents by providing a
comprehensive set of tools for creating and formatting a
document, memos, letters, reports, brochures, business
documents and even internet web pages.

•

Microsoft Office Access 2007

Starting word 2007 application

•

Microsoft Office PowerPoint 2007

•

Microsoft Office Publisher 2007

•

Microsoft Office Outlook 2007

Click the Mouse on Start
All Programs
Microsoft
Office 2007
Microsoft Office Word 2007. Microsoft
Office Word 2007 opens along with a default blank document
named with Document1 and has tabs and buttons. 1) Office
button, 2) Quick Access Toolbar, 3) Tabs, and 4) Ribbon
as on Fig 1.

Fig 1

Office Button

Quick Access Toolbar

1 This is the Office button which is similar to the File menu
in MS word 2003 as on Fig 2.
A Start new project; Open a Project, Save, Print, etc.

Tabs

Ribbon

C This opens the Word Options window where you can
change settings and customize your Quick Access
Toolbar.

B This shows recent documents and is a quick way to
open a recent project.
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Fig 3

Fig 2

2 This is the Quick Access Toolbar. With this tool bar one
can set it up to needs. To do so just click the arrow at
the end of this bar and select which items best suit
needs.

If you scroll your mouse over one of the Styles in the Home
tab it will show in your paper what it will look like before
clicking the style. Now the categories in each Ribbon may
have a button at the end of its bar.

They will be placed in the order they are selected. Again to
customize this Quick Access Toolbar go to the office
button and select Word Options. Click customize on the
left and search for any buttons that suit needs. A Shortcut
to customize this bar is to right click in the Tabs bar and
select Customize Quick Access Toolbar.

If you click this button it will expand into a window and show
more options.(Fig 4). For example the Font category will
expand into a window where it will have all the settings for
the font and character spacing.

3 This is the Tabs Bar. Tabs are similar to the menu
system of MW2003 instead of having dropdown menus.
MsWord 2007 created the Tab and Ribbon system.
When you select a tab it will display the Ribbon
associated with that tab. Here everything has been
changed into button form.
4 The tabs display a Ribbon. In this Ribbon there are
many buttons that are grouped into categories such as
Clipboard, Font, and Paragraph as on Fig 3.
It will help if you take a couple minutes to look through all
the tabs and Ribbons to learn the layout and to remember
where to find buttons when working on projects and papers.
Another new feature is the preview feature.
44

1

Title bar will appear at the top of the application
window. It displays the name of the currently active
word document1 along with a name of application.

2

Office button contains the file attribute options and
recently opened document list to quick access. It has
the word options to set the properties of few actions.

3

Menu bar Shows the Home, Insert, Page Layout,
references, Mailings, Review, View menus and Help
button.

4

Vertical scroll is bar used to align text or objects in the
document. The measuring units can be changed according to our requirements.

5

Status bar shows the current position of the cursor
and indicates page number and words.
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Fig 4

1. Title bar
2. Office button
3. Menus
4. Vertical Ruler
5. Status bar
6. Layout view
7. Zoom
8. Vertical Scroll bar
9. Close button
10.Maximize button
11.Minimize button
12.Styles
13.Horizontal Ruler
14.Formatting tools
15. Tab setting button
16.Customize Quick Access Toolbar
17.Work area

6

Layout View can be used to switch the view mode of
the active document. This contains Print Layout, Full
Screen Reading, Web Layout, Outline and Draft.

15

Tab button is the place where the type of tab can be
selected such as left tab, right tab, centre tab, decimal tab, etc.,

7

Zoom option can be used to zoom the document to
fine tune the objects and read text clearly. The Zoom
options has 10% to 500% enlargement.

16

Customize Quick Access toolbar is a shortcut bar
where the familiar and repeat functions tools can be
kept there.

8

Horizontal Scroll bar is used to move the document
up/down to view the entire document

17

Work space the space is the area in which you can
enter the text of your document.

9

Close button is located at the top right corner of the
window. It is used to close the document as well as
the application window.

Create a New Document

10

Maximize buttons are used to maximize the document when it was minimized.

11

Minimise button, when this button is clicked the
active document will be minimized on to the taskbar
of the windows.

12

Styles are some pre-defined format for the quick
format for the text.

13

Horizontal ruler is useful to align text and objects and
the tab settings can be done on the horizontal ruler.

14

Formatting tool bar is important to give print effects to
the text document such as fonts, point size, toggle
bold, italic & underline, bulleting and number- ing

There are several ways to create new documents, open
existing documents, and save documents in Word:
•

Click the Microsoft Office Button and Click New or

•

Press CTRL+N (Depress the CTRL key while pressing
the "N") on the keyboard

When you click on the Microsoft Office Button and Click
New, you have many choices about the types of documents you can create. If you wish to start from a blank
document, click Blank as on Fig 5.
If you wish to start from a template, you can browse through
your choices on the left, see the choices on center screen,
and preview the selection on the right screen.
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Selecting Text

Fig 5

To change any attributes of text it must be highlighted first.
Select the text by dragging the mouse over the desired text
while keeping the left mouse button depressed, or hold
down the SHIFT key on the keyboard while using the arrow
buttons to highlight the text. The following table contains
shortcuts for selecting a portion of the text.
Selection

Technique

Whole word

double-click within the word

Whole paragraph

triple-click within the para
graph

Opening an Existing Document

Several words or lines hold down SHIFT while using
the arrow keys

•

Click the Microsoft Office Button and Click Open, or

Entire document

•

Press CTRL+O (Depress the CTRL key while pressing
the "O") on the keyboard, or

•

If you have recently used the document you can click
the Microsoft Office Button and click the name of the
document in the Recent Documents section of the
window. Insert picture of recent docs

Saving a Document
•

Click the Microsoft Office Button and Click Save or Save
As (remember, if you're sending the document to
someone who does not have Office 2007, you will need
to click the Office Button, click Save As, and Click
Word 97-2003 Document), or

•

Press CTRL+S (Depress the CTRL key while pressing
the "S") on the keyboard, or

•

Click the File icon on the Quick Access Toolbar

choose Editing | Select | Se
lect All from the Ribbon or
press CTRL+A

Deselect the text by clicking anywhere outside of the
selection on the page or press an arrow key on the
keyboard.
Inserting Additional Text
Text can be inserted in a document at any point using any
of the following methods as on Fig 6.
Fig 6

Close a Document
To close a document
•

Click the Office Button

•

Click Close Editing a Document

Typing and inserting Text
The text will appear where the blinking cursor is located.
Move the cursor by using the arrow buttons on the
keyboard or positioning the mouse and clicking the left
button. The keyboard shortcuts listed below are also
helpful when moving through the text of a document

46

Move Action

Keystroke

Beginning of the line

HOME

End of the line

END

Top of the document

CTRL+HOME

End of the document

CTRL+END

Type Text: Put your cursor where you want to add the text
and begin typing
Copy and Paste Text: Highlight the text you wish to copy
and right click and click Copy, put your cursor where you
want the text in the document and right click and click
Paste.
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Cut and Paste Text: Highlight the text you wish to copy,
right click, and click Cut, put your cursor where you want
the text in the document, right click, and click Paste.
Drag Text: Highlight the text you wish to move, click on it
and drag it to the place where you want the text in the
document. As on No.

Undo Changes To undo changes
•

Click the Undo Button on the Quick Access Toolbar as
on Fig 9.
Fig 9

Rearranging Blocks of Text
To rearrange text within a document, you can utilize the
Clipboard Group on the Home Tab of the Ribbon as on
Fig 7
Fig 7

Format text
The easiest way to format text is to make use of the
formatting toolbar. The formatting toolbar is shown in
(Fig.10) and can be found under the HOME Menu toolbar.
Fig 10

Insert picture of clipboard group labelled
•

Move text: Cut and Paste or Drag as shown above

•

Copy Text: Copy and Paste as above or use the
Clipboard group on the Ribbon

Paste Text: Ctrl + V (hold down the CTRL and the "V" key
at the same time) or use the Clipboard group to Paste,
Paste Special, or Paste as Hyperlink
Deleting Blocks of Text
Use the BACKSPACE and DELETE keys on the keyboard to delete text. Backspace will delete text to the left
of the cursor and Delete will erase text to the right. To delete
a large selection of text, highlight it using any of the
methods outlined above and press the DELETE key.
Search and Replace Text
To find a particular word or phrase in a document:
•

Click Find on the Editing Group on the Ribbon

•

To find and replace a word or phrase in the document,
click Replace on the Editing Group of the Ribbon as on
Fig 8.
Fig 8

Font menu: Allows you to choose from a wide number of
fonts. To select a particular font click on the arrow head
beside the box, scroll down with the scrollbar until you
select a particular font and select it by clicking on it.
Font Size: Select a size for your font by clicking on the
arrowhead and scrolling down and clicking on the size that
you desire. If you want to change the font of text which has
already been typed in, highlight the text and then select the
size as mentioned above.
Font Style: You may select whether you want to make the
font Bold, Italicized or underlined.
Alignment: The text may be aligned to the left, right or
center or can be aligned to the right side or can be justified
across the page.
Numbered and Bulleted lists: Creates a numbered or
bulleted list.
Increase/Decrease indent: Change the indentation of a
paragraph in relation to the side of the page.
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Outside Border: Add a border around a text selection.
Highlight Color: This option may be used to change the
color behind the selected text.

The Font dialogue box allows you to select from a larger
selection of formatting options. Click on the down arrow
button on the Font toolbar to access the box as on Fig 11.

Text Color: This option changes the color of the text
selected.

Fig 11

Formatting Paragraphs

Fig 12

A paragraph may be formatted by placing the cursor within
the paragraph and selecting the downward arrow, in the
paragraph Section of the HOME menu toolbar. (Fig 12)
•

Alignment: This is used to align the text horizontally
either to the

•

left, center, right or justified.

•

Indentation: This indicates the distance the text is
indented from

•

the left and right edges of the page.

•

Special: Select special indents for first lines and
hanging indents.

•

Line Spacing: Set the line spacing for the text.

Change a Style in Microsoft Word 2007
Using Styles in Microsoft Word 2007 is an efficient way to
format documents as on Fig 13. However, you may on
occasion have problems changing Styles. If you are having
problems changing Styles, the following may help you.
This may even be helpful for you if you have successfully
changed Styles in Microsoft Word 2007 in the past, but for
some reason the changes now do not seem to take effect.
Quick Styles are styles promoted into Word 2007's Styles
gallery on the Home ribbon.
•

Quick Styles provide easy access to and visibility of
frequently used styles.

•

Quick Styles provide an thumbnail preview to the
formatting of a style.

•

Styles applied in a document, by default, appear in the
Quick Styles gallery.
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Fig 13

•

New styles created in Word 2007, by default, become
a Quick Style.

•

Quick Styles are quickly defined from the right click
menu and travel with the document.

Insert Tab
The Insert Tab is right next to the Home Tab in Microsoft
Word 2007. This tab has a lot of useful features that will let
you insert things like pictures, clip art images, shapes,
Smart Art graphics, charts and a host of other items. Let
us review a few of these features in this exciting new tab.
Before that here is a screen shot of the insert tab shown
Fig 14.
A common task in Microsoft Word is to add a Page Break.
For this practice use the definition assignment document
as illustrated below.
To add a page break right before the Research Analysis
section. In order to do this in Microsoft Word 2007 select
the Insert Tab and then select the Pages group and then
choose Page Break.

Fig 14

Here is a screen shot of this action as on Fig 15.
Fig 15

•

Place the cursor on the page where you want the new
table

•

Click the Insert Tab of the Ribbon as on Fig.16
Fig 16

Adding Tables
Tables are used to display data in a table format.
Create a Table
To create a table

•

Click the Tables Button on the Tables Group. You can
create a table in one of four ways

•

Highlight the number of row and columns

•

Click Insert Table and enter the number of rows and
columns
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•

Click the Draw Table, create your table by clicking and
entering the rows and columns

•

Click Quick Tables and choose a table

Enter Data in a Table

Modify the Table Structure and Format a Table
To modify the structure of a table
•

Click the table and notice that you have two new tabs
on the Ribbon: Design a Layout as on Fig 17.

Place the cursor in the cell where you wish to enter the
information. Begin typing.
Fig 17

These pertain to the table design and layout.
On the Design Tab, you can choose
•

Table Style Options

•

Table Styles

•

Draw Borders

To format a table, click the table and then click the Layout
Tab on the Ribbon as shown in Fig 18.
This Layout tab allows you to
•

View Gridlines and Properties (from the Table Group)

•

Insert Rows and Columns (from the Rows & Columns
Group)

Fig 18

•

Delete the Table, Rows and/or Columns (from the Rows
& Columns Group)

•

Merge or Split Cells (from the Merge Group)

•

Increase and Decrease cell size (Cell Size Group)

•

Align text within the cells and change text directions
(Alignment Group)

Fig 20

Word 2007 allows you to insert illustrations and pictures
into a document. To insert illustrations as shown in Fig 19.
Fig 19

Insert Picture
The first selection in Illustrations is Insert a picture from a
file as on Fig 20.
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When clicked on this a window will open. Browse to a
photograph or other picture you have saved on your
computer. Use this to create birthday invitation for friends
with their current picture in the background. It can have a
lot of fun incorporating personal photos into the documents.
Clip Art
•

Place your cursor in the document where you want the
illustration/picture

•

Click the Insert Tab on the Ribbon

•

Click the Clip Art Button

•

The dialog box will open on the screen and you can
search for clip art as on Fig 21.

•

Choose the illustration you wish to include

Smart Art
•

Smart Art is a collection of graphics you can utilize to
organize information within the document. It includes
timelines, processes, or workflow

•

Place your cursor in the document where you want the
illustration/picture

•

Click the Insert Tab on the Ribbon

•

Click the Smart Art button

•

Click the Smart Art you wish to include in your document as on Fig 22.

•

Click the arrow on the left side of the graphic to insert
text or type the text in the graphic.
Fig 22

Fig 21
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.2.06
Secretarial Practice (English) - Formation of words, phrases and practice of MS word
MS Word - Editing and Formatting
Objectives: At the end of this lesson you shall be able to
• state about the basic word processing
• explain how to open and save documents
• describe how to select and edit the font
• state formatting and enhancing procedure
• explain the printing process for document.
A word processing program is a software program that
includes tools for entering, editing, and formatting text and
graphics. Microsoft Word is a powerful word processing
program that allows you to create and enhance a wide
range of documents quickly and easily. The electronic files
you create using Word are called documents. One of the
benefits of using Word is that document files can be stored
on a hard disk, CD, flash drive, or other storage device,
making them easy to transport, exchange, and revise.
You can use Word to accomplish the following tasks:
Type and edit text
The Word editing tools make it simple to insert and delete
text in a document. You can add text to the middle of an
existing paragraph, replace text with other text, undo an
editing change, and correct typing, spelling and
grammatical errors with ease.
Copy and move text from one location to another
Using the more advanced editing features of Word, you
can copy or move text from one location and insert it in a
different location in a document. You also can copy and
move text between documents. This means you don't have
to retype text that is already entered in a document.
Format text and paragraphs with fonts, colors, and
other elements

Enhance documents with tables, charts, diagrams,
and graphics
Using the powerful graphics tools in Word, you can spice
up your documents with pictures, photographs, lines,
shapes, and diagrams. You also can illustrate your
documents with tables and charts to help convey your
message in a visually interesting way.
Use Mail Merge to create form letters and mailing
labels
The Word Mail Merge feature allows you to send
personalized form letters to many different people. You
can also use Mail Merge to create mailing labels,
directories, e-mail messages, and other types of
documents.
Share documents securely
The security features in Word make it quick and easy to
remove comments, track changes, and unwanted personal
information from your files before you share them with
others. You can also add a password or a digital signature
to a document and convert a file to a format suitable for
publishing on the Web.
The Elements of Word 2010 Screen
The elements are shown in Fig.1

The sophisticated formatting tools in Word allow you to
make the text in your documents come alive. You can
change the size, style, and color of text, add lines and
shading to paragraphs, and enhance lists with bullets and
numbers. Creatively formatting text helps to highlight
important ideas in your documents.

•

The title bar displays the name of the document and
the name of the program. Until you give a new document
a different name, its temporary name is Document 1.
The title bar also contains resizing buttons and the
program Close button. These buttons are common to
all Windows programs.

Format and design pages

•

The Quick Access toolbar contains buttons for saving
a document and for undoing, redoing, and repeating a
change. You can modify the Quick Access toolbar to
include the commands you use frequently.

•

The File tab provides access to Backstage view, where
you manage files and the information about them.
Backstage view includes commands related to working
with documents, such as opening, printing, and saving
a document. The File tab also provides access to
resources for help using Word and to the Word Options
dialog box, which is used to customize the way you
use Word.

The page-formatting features in Word give you power to
design attractive newsletters, create powerful résumés,
and produce documents such as research papers,
business cards, CD labels, and books. You can change
the paper size and orientation of your documents, organize
text in columns, and control the layout of text and graphics
on each page of a document. For quick results, Word
includes preformatted cover pages, pull quotes, and
headers and footers, as well as galleries of coordinated
text, table, and graphic styles that you can rely on to give
documents a polished look. If you are writing a research
paper, Word makes it easy to manage reference sources
and create footnotes, endnotes, and bibliographies.
52

Copyright @ NIMI Not to be Republished

•

The Ribbon contains the Word tabs. Each tab on the
Ribbon includes buttons for commands related to
editing and formatting, documents. The commands are
organized in groups. For example, the Home tab
includes the Clipboard, Font, Paragraph, Styles, and
Editing groups. The Ribbon also includes the Microsoft
Word Help button,which you use to access the Word
Help system.

•

The document window displays the current document.
You enter text and format your document in the
document window.

Fig 1

•

The rulers appear in the document window in Print
Layout view. The horizontal ruler displays left and right
document margins as well as the tab settings and
paragraph indents, if any, for the paragraph in which
the insertion point is located. The vertical ruler displays
the top and bottom document margins.

•

•

The vertical scroll bar and the horizontal scroll bar are
used to display different parts of the document in the
document window. The scroll bars include scroll boxes
and scroll arrows, which you can use to scroll through
a document.

Across the top of the Ribbon is a series of tabs. You can
click one of these tabs to expose a set of controls specific
to that tab. Initially, the Ribbon displays these seven tabs:

•

•

The status bar displays the page number of the current
page, the total number of pages and words in the
document, and the status of spelling and grammar
checking. It also includes the view buttons, the Zoom
level button, and the Zoom slider. You can customize
the status bar to display other information.
The view buttons on the status bar allow you to display
the document in Print Layout, Full Screen Reading,
Web Layout, Outline, or Draft view.

The Zoom level button and the Zoom slider provide quick
ways to enlarge and decrease the size of the document
in the document window, making it easy to zoom in on
a detail of a document or to view the layoutof the
document as a whole.
Ribbons

Home: Basic commands for creating and formatting
documents. You can find controls for working with the
Clipboard, setting the font, formatting paragraphs, applying
styles, and using Find and Replace.
Insert: Commands for inserting various items into your
document, including new pages, tables, pictures, shapes,
and other types of illustrations, headers and footers,
specially formatted text, etc
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Page Layout: Commands that let you adjust the layout
of your document's pages. You can apply a theme to your
document to set the overall look of the document or control
details such as the page margins and background colors.

Word 2010 Keyboard Shortcuts
A shortcut key is a function key, such as [F1], or a
combination of keys, such as [Ctrl][S], that you press to
perform a command. For example, instead of using the
Cut, Copy, and Paste commands on the Ribbon or the
Mini toolbar, you can use the keyboard shortcuts [Ctrl][X]
to cut text, [Ctrl][C] to copy text, and [Ctrl][V] to paste
text. You can also press [Ctrl][S] to save changes to a
document instead of clicking the Save button on the Quick
Access toolbar or clicking Save on the File tab. Becoming
skilled at using keyboard shortcuts can help you quickly
accomplish many of the tasks you perform in Word. If a
keyboard shortcut is available for a command, then it is
listed in the ScreenTip for that command.

References: Commands that let you create tables of
contents, footnotes,bibliographies, indexes, and other
elements.
Mailings: Commands for creating mail merges.
Review: Commands for proofing and adding comments
to your documents and tracking changes.
View: Commands that let you change the view. You can
use this tab to switch to different document views, to show
or hide certain types of information (such as paragraph
marks), and to zoom in for a closer look at your document.

WORD 2003 COMMAND

Word 2010 offers a number of helpful keyboard shortcuts
for performing tasks quickly. Here are some shortcuts for
common Word formatting, editing, and file and document
tasks.
EQUIVALENT WORD 2010 COMMAND

File Æ New

File tab, New

File Æ Save

File tab, Save

File Æ Page Setup

Page Layout tab, Page Setup group

Edit Æ Undo

Quick Access toolbar, Undo

Edit Æ Find

Home tab, Editing group, Find

Edit Æ Replace

Home tab, Editing group, Replace

Insert Æ Picture Æ Clip Art

Insert tab, Illustrations group, Clip Art

Insert Æ Picture Æ From File

Insert tab, Illustrations group, Picture

Insert Æ Diagram

Insert tab, Illustrations group, SmartArt

Format Æ Font

Home tab, Font group, dialog box launcher

Format Æ Paragraph

Home tab, Paragraph group, dialog box launcher

Format Æ Styles and Formatting

Home tab, Styles group, dialog box launcher

Tools Æ Spelling and Grammar

Review tab, Proofing group, Spelling & Grammar

Tools Æ Letters and Mailings

Mailings tab

Tools Æ Templates and Add-Ins

File tab, Options, Add-Ins tab, select Templates in the Manage
drop-down list and click Go

Tools Æ Options

File tab, Options

Table Æ Draw Table

Insert tab, Tables group, Table
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Word 2010 Editing Shortcuts
Command

Shortcut

Ribbon Location

Undo

Ctrl+Z

Quick Access toolbar

Cut

Ctrl+X

Home tab, Clipboard group

Copy

Ctrl+C

Home tab, Clipboard group

Paste

Ctrl+V

Home tab, Clipboard group

Select All

Ctrl+A

Home tab, Editing group

Find

Ctrl+F

Home tab, Editing group

Replace

Ctrl+H

Home tab, Editing group

Word 2010 File and Document Shortcuts

4 Click the Open button.
Save a Document in Word 2010
1 Click the File tab and select the Save as command: The Save As dialog box appears. You need to
use the Save As dialog box is when you first create a
document and if you want to save a document with a
new name or to a different location on disk.
2 Type a name for your document in the File Name
text box: Word automatically selects the first line or
first several words of your document as a filename and
puts it in the Save dialog box. If that's okay, you can
move to Step 4. Otherwise, type a name in the File
Name box.

Command

Shortcut

Ribbon Location

3 Choose a location for your file (Optional): In the
Save As dialog box to choose a specific folder for your
document.

New

Ctrl+N

File tab, New command

4 Click the Save button.

Open

Ctrl+O

File tab, Open command

Save

Ctrl+S

File tab, Save command

Print

Ctrl+P

File tab, Print command

Help

F1

Help button at top right of
Ribbon

New Page

Ctrl+Enter Insert tab, Pages group

Word 2010 Formatting Shortcuts
Command Shortcut

Ribbon Location

Bold

Ctrl+B

Home tab, Font group

Italic

Ctrl+I

Home tab, Font group

Underline

Ctrl+U

Home tab, Font group

Center

Ctrl+E

Home tab, Paragraph group

Left Align

Ctrl+L

Home tab, Paragraph group

Right Align Ctrl+R

Home tab, Paragraph group

Justify

Home tab, Paragraph group

Ctrl+J

Clear
Ctrl+
Formatting Space bar

Home tab, Font group

Open a Document in Word 2010
There are several ways to open a Word 2010 document
that was previously saved as a file on disk.
1 Choose the Open command from the File tab menu:
Alternatively, you can use the keyboard shortcut Ctrl+O.
Either way, the Open dialog box opens
2 Locate the document you want to open: The Open dialog box , you can examine various folders on your PC's
hard drive, and on any computer network your PC is
connected to, for files to open.
3 When you find the file, select it: The file appears highlighted in the dialog box.

Word wrap
In word processing, a feature that causes the word processor to force all text to fit within the defined margins.
When you fill one line with text, the word processor automatically jumps to the next line so that you are not required to keep track of line lengths and to press the Return key after each line. The word processor divides lines
in such a way that a word is never split between two lines
(unless the word processor supports hyphenation).
Word wrap also occurs if you change the margins. In this
case, the word processor readjusts all the text so that it
fits within the new margins.
Note that word wrap inserts a soft return at the end of
each line, not a hard return. Soft returns are invisible codes
that the word processor utilizes. Hard returns are real characters inserted into the document.
Some word processors allow you to turn off the word-wrap
feature. This is useful for writing programs and other types
of formatted text where you want complete control over
new lines.
Using the Undo , Redo and Repeat commands
Word remembers the editing and formatting changes you
make so that you can easily reverse or repeat them. You
can reverse the last action you took by clicking the Undo
button on the Quick Access toolbar, or you can undo a
series of actions by clicking the Undo list arrow and selecting the action you want to reverse. When you undo an
action using the Undo list arrow, you also undo all the
actions above it in the list-that is, all actions that were
performed after the action you selected. Similarly, you
can keep the change you just reversed by using the Redo
button on the Quick Access toolbar. The Redo button appears only immediately after clicking the Undo button to
undo a change. If you want to repeat an action you just
completed, you can use the Repeat button on the Quick
Access toolbar. For example, if you just typed "thank you,"
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clicking inserts "thank you" at the location of the insertion point. If you just applied bold, clicking applies bold to
the currently selected text. You also can repeat the last
action you took by pressing [F4].
Selecting Text
One basic editing skill is selecting text. After you select
some text, you can delete it, copy it, move it, apply formatting to it, change its capitalization etc. The easiest
way to select text is to click and drag the mouse over the
text you want to select. You can also use one of these
mouse actions to select text:

• To select all text between two points: Click at the start
of the block of text, hold down Shift, and click at the
end of the block.

• To select a single word: Double-click anywhere on the
word. Click, click.

• To select an entire paragraph: Triple-click anywhere
on the paragraph. Click, click, click.

• To select an entire sentence: Hold down Ctrl and click
anywhere in the sentence.

Moving a cell selection
To move a cell selection with Cut and Paste, follow these
steps:
1 Select the cells containing data you want to move.
2 Click the Cut button in the Clipboard group on the Home
tab (the button with the scissors icon). Alternatively,
press Ctrl+X. The program surrounds the cell selection
with a marquee and displays the following message
on the Status bar: Select destination and press ENTER
or choose Paste.
3 Move the cell cursor to, or click the cell in the upperleft corner of the destination range. When you indicate
the destination range, Excel only needs to know the
location of the cell in the upper-left corner of the
destination range.
4 Press Enter or Ctrl+V to complete the move operation.
Alternatively, you can click the Paste button in the
Clipboard group on the Home tab. The cell contents
disappear from where they began and reappear in their
new location.
Copying a cell selection

• To select a column of text: Hold down Alt, click and

Copying a cell selection with the Copy and Paste
commands follows a nearly identical procedure to the one
you use with the Cut and Paste commands. After selecting
the range to copy, you click the Copy button on the Home
tab or press Ctrl+C.

Deleting Text

An advantage to copying a selection with the Copy and
Paste commands and the Clipboard is that you can paste
the information multiple times. Just make sure that, instead
of pressing Enter to complete the first copy operation,
you click the Paste button on the Home tab of the ribbon
or press Ctrl+V. After you select the first cell of the next
range where you want the selection copied, choose the
Paste command again. When you make the last copy,
press Enter. If you forget and choose Paste, you can
remove the marquee around the original cell range by
pressing the Esc key.

hold the mouse button, and drag. Drag the mouse left
or right to increase or decrease the width of the column
selected, and drag the mouse up or down to extend
the column up or down.

Deleting text is one of the basic skills of good editing.Word
has many ways to delete text. The most basic deletion
technique is to delete characters one at a time by pressing
one of these two keys:
Backspace: Deletes the character to the left of the
insertion point
Delete: Deletes the character to the right of the insertion
point
Delete large amounts of text
To delete a sentence: Hold down the Ctrl key and click
in the sentence to select it, and then press Delete or
Backspace.
To delete a paragraph: Triple-click the paragraph to
select it and then press Delete or Backspace.
To delete the entire document: Press Ctrl+A to select
the entire document and then press Delete or Backspace.
Cut, Copy, and Paste in Excel 2010
You can use the Cut, Copy, and Paste commands to move
or copy information in an Excel 2010worksheet Because
of this Clipboard arrangement, you can use these
commands to move or copy information to any other
worksheet open in Excel or even to other programs running
in Windows (such as a Word document).
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Formatting Text using fonts
Formatting text with fonts is a quick and powerful way to
enhance the appearance of a document. A font is a
complete set of characters with the same typeface or
design. Arial, Times New Roman, Courier, Tahoma, and
Calibri are some of the more common fonts, but there are
hundreds of others, each with a specific design and feel.
Another way to change the appearance of text is to
increase or decrease its font size. Font size is measured
in points. A point is 1/ 72 of an inch. You change the font
and font size of the body text, title, and headings .
Font & Size selection
Font refers to the manner or style in which text is displayed
in the document. Different fonts contain different collection
of characters and symbols. Word offers many ways to
change fonts and font styles. The text to be formatted
needs to be selected first.
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Follow these steps to change fonts and font styles

• Open the File group.

Fig.3

• Use Bold(B), italics(I), Underline(U) buttons on the
format toolbar.

• To add bold formatting to the text, follow these steps:
• Select the text and click on the Bold button.
• Alternatively, click on the bold button and type the text.
Similarly, the characters can be underlined and
italicized.

Changing Font Size
Font size is measured in points and picas are used for
measuring spacing, line thickness, and so on. There are
12 points to a pica and six picas to an inch; therefore,
there are 72 points to an inch. Normal template the font
size, follow these steps:Use the drop-down front size on
the formatting toolbars, type the font size, in the font size
box on the format toolbar and press the Enter key.

Justification (Fig 4)
You can set the paragraph alignment to Align Left, Align
Right, Center, orJustify by using the first four buttons at
the bottom of the Paragraph group on the Home tab on
the Ribbon. The different ways you can align text using
the Ribbon are
Fig.4

Use any of these keyboard shortcuts to increase or
decrease the font size
To increase the Font size select the matter and press
Ctrl+Shift+> keys. To
decrease the font size select the matter and press
Ctrl+Shift+< keys. Alternatively
you can use Ctrl+] or Ctrl+[ to increase or decrease the
font size.
Format Painter (Fig 2)
The Format Painter is a very useful option, it copies the
formatting from specific portions of the document and
applies it to other portions of your document with a few
clicks. The process is very simple, select the portion of
the document, hit the Format Painter option and then select
the new paragraph upon which you wish to apply the format
of the first paragraph.
Fig.2

Line spacing
In the Paragraph group on the Home tab on the Ribbon,
you find the Line and Paragraph Spacing button, which
you use to add space between the lines of text in a
paragraph. By default, lines are single spaces, with slightly
more than that amount below a paragraph. In the Line and
Paragraph Spacing drop-down list (in the Paragraph group
on the Home tab), you can select several options for the
paragraph's line spacing. The ones you use most are 1.0,
1.5, and 2.0. Click the dialog box launcher to open the
Paragraph dialog box, where you can select one of these
options from the Line Spacing drop-down list:
At Least: Specify a minimum measurement for the line
spacing, such as At Least 14 Points.
Exactly: Set an exact measurement.
Multiple: Set other amounts of line spacing, such as 3
Lines.
The following keyboard shortcuts can help you quickly
format paragraph spacing:

Formatting Paragraphs (Fig 3)
To format a paragraph, first click anywhere in the paragraph
you want to format. (Where you click in the paragraph
doesn't matter.) Then use one ofthe keyboard shortcuts or
buttons on the Ribbon. To remove all paragraph formatting,
press Ctrl+Q.

Keyboard Shortcut

Effect on Paragraph

Ctrl+1

Single-space

Ctrl+2

Double-space

Ctrl+5

1.5 line spacing
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Computer
Setting indents and spacing, use of help options, page set up, margins, ruler, and paper size in word.
Inserting lines and page breaks, viewing documents properties and printing, use of tables, insertion
and deletion of rows and columns, alignments between rows and columns and other MS-word features.
Borders

Fig 6

The Paragraph group on the Home tab on the Ribbon has
a Border button you can use to apply basic borders. You
can click the button to apply the current border type to
whatever text you select. Click the arrow next to the button to reveal a palette of border types, as shown in Fig.5
To draw a simple box around some text and choose a
Fig 5

Some publications require that you indent the first line of
every paragraph.Others require that you indent all lines by
moving them to the right - useful for nested paragraphs (a
paragraph within a paragraph) .Place the insertion point
somewhere in the paragraph you want nested and click
the Increase Indent button in the Paragraph group on the
Home tab. if you continue to click it, you increase the
indent. To unindent an indented paragraph, use the
Decrease Indent button.
1 Open the Paragraph dialog box by using the dialog
box launcher in the Paragraph group on the Home tab
on the Ribbon.
2 In the Indentation area, select the First Line option from
the Special drop-down list.
3 If you want, change the amount in the By box. The
box automatically says 0.5" and can be changed by
typing over the figure or using the spinner buttons to
the right of the text.
4 Click OK.

border, follow these simple steps:
1 Select the text you want to draw a border around.
2 Click the down arrow on the Borders button in the Paragraph group in the Home tab on the Ribbon and select
the Outside Borders option.
3 To change the border's style, color, or width, select the
Borders and Shading option at the bottom of the Border buttons dropdown list. This step opens the Borders tab in the Borders and Shading dialog box.
4 Make your selections in the Borders and Shading dialog box (Fig 6).
Indenting
58

To indent everything except the first line of a paragraph,
select Hanging Indent from the drop-down list in Step 2.
First line & Hanging Indent
In many types of documents, you may wish to indent only
the first line of each paragraph. This helps to visually separate paragraphs from one another. It's also possible to
indent every line except the first line, which is known as a
hanging indent.
To create or adjust a First Line Indent or Hanging
Indent (Fig 7)
1 Place the insertion point anywhere in the paragraph
you wish to indent, or select one or more paragraphs.
2 To adjust the first line indent, drag the First Line Indent
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2 Make sure you are on the Home tab.

Fig 7

3 Click the Increase Indent command to increase the
indent by increments of 1/4 inch (Fig 8).
Fig 8

The three indent markers

First line Indent

Increasing the indent

4 Click the Decrease Indent command to decrease the
indent by increments of 1/2 inch. If you would prefer to
type in your indent amounts, you can use the Indent
fields on the Page Layout tab (Fig 9).
Fig 9

Typing an indent amount

Hanging Indent

Spell Check
Word checks your spelling and grammar as you type.
Spelling errors display with a red wavy line under the word.
Grammar errors display with a green wavy line under the
error. If you want to spell check your entire document,
press F7 and click the spelling icon, or choose Spelling
and Grammar from the review group. If you want to spell
check part of your document highlight the area you want
to spell check. Then press F7 and click the spelling icon,
or choose Spelling and Grammar from the review group
Using the Thesaurus
One effective Word feature is a built-in thesaurus that can
quickly show you synonyms for a word you type.

marker on the ruler.
3 To adjust the hanging indent, drag the Hanging Indent
marker.
4 To move both markers at the same time, drag the Left
Indent marker. This will indent all of the lines in the
paragraph.
To Use the Indent Commands
If you want to indent all of the lines in a paragraph, you
can use the Indent commands on the Home tab.
1 Select the text you wish to indent.

1 Right-click a word you typed and choose Synonyms
from the menu that appears. A menu that lists synonyms for the word appears. (Sometimes, Word throws
an antonym into the list, just to be contrary)
2 Click the word that you want to replace your word.
Word replaces the original word with your selection.
Inserting a Table
A table is a grid made up of rows and columns of cells that
you can fill with text and graphics. A cell is the box formed
by the intersection of a column and a row. The lines that
divide the columns and rows and help you see the gridlike structure of a table are called borders. You can create
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a table in a document by using the Table command in the
Tables group on the Insert tab. Once you have created a
table, you can add text and graphics to it.
Insert Table: Create a table with any number of columns
and rows and select an AutoFit behavior
Draw Table: Create a complex table by drawing the table
columns and rows
Convert Text to Table: Convert text that is separated by
tabs, commas, or another separator character into a table
Excel Spreadsheet: Insert a blank Excel worksheet into
the document as an embedded object
Quick Tables: Insert a preformatted table template and
replace the placeholder data with your own data
Format a Table in Word 2010
To format a table in Word 2010 - maybe adding a row,
adjusting the width of a table element - you can use Word's
Table Tools tabs after the table has been created. The
Table Tools tabs show up only when a table is being edited or selected. .

Manipulating a Word table with the mouse

• Clicking-and-dragging the mouse on a vertical line in

the table's grid allows you to adjust the line left or right,
and resize the surrounding cells.

• You can also adjust cell width by using the Ruler, by
pointing the mouse at the Move Table Column button
that appears above each table cell gridline.

• Clicking-and-dragging the mouse at a horizontal line

allows you to adjust the line up or down, and change
the row height of surrounding cells.

Adjusting the Word table (Fig 10)
It's the Table Tools Layout tab that contains many of the
command buttons and items that let you manipulate and
adjust a table. Start your table design by placing the
insertion pointer somewhere within the table itself, which
makes the Table Tools Layout tab appear:

Fig 10

Deleting cells, columns, or rows: Position the insertion
pointer in the part of the table you want to remove, then
choose the table element to remove from the Delete
button's menu.
When you choose the Delete Cells command,
you see a dialog box asking what to do with
the other cells in the row or column: move
them up or to the left. Yes, deleting a cell may
make your table asymmetrical.
Inserting columns or rows: Four commands in the Rows
& Columns group make this task possible: Insert Above,
Insert Below, Insert Left, and Insert Right. The row or
column that's added is relative to where the insertion pointer
is within the table.
Adjusting row and column size: Cell Size group let
you fine-tune the table's row height or column width. The
Distribute Rows and Distribute Columns command buttons,
found in the Cell Size group, help clean up uneven column
or row spacing in a table.
Aligning text: Text within a cell can be aligned just like a
paragraph: left, center, or right. Additionally, the text can
be aligned vertically: top, middle, or bottom.
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Reorienting text: The Text Direction button in the
Alignment group changes the way text reads in a cell or
group of selected cells. Normally, text is oriented from left
to right. By clicking the Text Direction button once, you
change the text direction to top-to-bottom. Click the button
again and direction is changed to bottom-to-top. Clicking
a third time restores the text to its normal direction.
Designing a Word table
The Table Tools Design tab is used to help you quickly
format your table. The tab shows up whenever the insertion
pointer lies somewhere in a table
Using Quick Styles: The Table Styles group can quickly
apply formatting to any table. Choose a style or click the
menu button to see a whole variety of styles.
The Quick Styles don't work when you have a table in a
document created by or saved in an older version of Word.
Removing a table's lines: Occasionally, you may want
a table without any lines. Select the table and choose No
Border from the Borders menu.
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Fig 11

Having no lines (borders) in a table makes working with
the table more difficult. The solution is to show the table
gridlines.To do that, select the table and choose the Show
Gridlines command from the Border menu.

Deleting a Word table

Merging cells: You can combine two or more cells in a
table by simply erasing the line that separates them. To
do so, click the Eraser command button found in the Draw
Borders group. The mouse pointer changes to an eraser.
Click a line and it's gone. Click the Eraser button again
when you finished merging.

Add Borders to Text:

Splitting cells: To turn one cell into two, you simply draw
a line, horizontally or vertically, through the cell. Click the
Draw Table command button in the Draw Borders group,
and then draw new lines in the table. Click the Draw Table
button again to turn off this feature.

To remove the table from your document, click the mouse
inside the table and then choose Delete?Table from the
Rows & Columns group on the Layout tab.
Following are the simple steps to add border to any text
or paragraph.
1 Select the text or paragraph to which you want to add
border. You can use any of the text selection method
to select the paragraph(s).
2 Click the Border Button to display a list of options to
put a border around the selected text or paragraph.
You can select any of the options available by simply
clicking over it (Fig 12).

Fig 12
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3 Try to add different borders like left, right top or bottom
by selecting different options from the border options
(Fig 13).

4 To delete the existing border, simply select No Border
option from the border options.

Fig 13

Add Borders to Page
You can add borders of your choice to word pages by
following the simple steps given below.

1 Click the Border Button to display a list of options to
put a border. Select Border and Shading option available
at the bottom of list of the options as shown in fig. This
will display a Border and Shading dialog box. This dialog
box can be used to set borders and shading around a
selected text or page borders (Fig 14).

Fig 14
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2 Click Page Border tab which will display a list of border
settings, styles and options whether this border should
be applied to the whole document or just one page or
first page.

3 You can use Preview section to disable or enable left,
right , top or bottom borders of the page.
4 You can customize yours border by setting its color,
width by using different arts available under style section
(Fig 15).

Fig 15

You can have similar or even better borders as given below
in Fig.16
Fig 16
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Add Shades to Text
1 Click the Border Button to display a list of options to
put a border. Select Border and Shading option available
at the bottom of list of the options as shown in fig 17.

This will display a Border and Shading dialog box. This
dialog box can be used to set borders and shading around
a selected text or page borders (Fig 17).

Fig 17

2 Click Shading tab which will display options to select
fill, color and style and whether this border should be
applied to Paragraph or Text.

3 You can use Preview section to have an idea about the
expected result. Once you are done, click OK button
to apply the result (Fig 18).

Fig 18
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3.3.3 Page Setup

Printing a document

Page setup can be used to change page orientation, set
left, top, bottom margins, page sizes, etc. To change page
size and orientation

Printing more than one copy

1 Select the Page layout group
2 Select the Margins tab.
3 In the orientation area, select Portrait or Landscape.
Setting Margins
1 Select the Page layout group
2 Select the margins tab.
3 Select custom margins and enter the measurement in
the Top, Bottom, Left and Right boxes.
4 Click on the OK button to close the dialog box. When
you set margins, Word applies the measurements to
all the pages in a document .
Choose paper size

The Copies box on the Print page lets you print more than
one copy of your document. You can click one of the arrows
next to this field to increase or decrease the number of
copies, or you can type directly in the box to specify the
number of copies.
The Collate setting, which lets you choose between
collated and uncollated printing. If you chose collated
printing (the default setting), Word prints each copy of
your document one at a time. In other words, if your
document consists of ten pages and you select three
copies and select collated printing, Word first prints all
ten pages of the first copy of the document, and then all
ten pages of the second copy, and then all ten pages of
the third copy. If you choose uncollated printing, Word
prints three copies of the first page, followed by three
copies of the second page, followed by three copies of the
third page, and so on (Fig. 19)

1 Select the Page layout group

Printing part of a document

2 Select the margins tab.

The Print All Pages drop-down list lets you choose how
much of (or what part of) your document you want to print.
When you first access the Print page in Backstage view,
the Print All Pages option is selected so that your entire
document prints. You use the other options in the Print All
Pages drop-down list, as well as the Pages box just below
it, to tell Word to print distinct portions of your document.

3 Select paper size
Print Preview
Previewing a document means viewing a screen
representation of one or more pages before you print them.
To print preview a document, the steps are:
1 Select the Print from File group. The document can be
previewed
Fig 19
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Print Selection: Print just the portion of the document
you selected before entering Backstage view. First, select the pages you want to print. Then choose File? Print,
select Print Selection from the Print All Pages drop-down
list, and click Print.
Print Current Page: Print just the current page. Before
you display the Print page, move to the page in your document that you want to print. Then select this option in the
Print page of Backstage view and click Print. This option
is handy when you make a change to one page and don't
want to reprint the entire document.
Print Range: Select specific pages for printing. You can
print a range of pages by typing the beginning and ending
page numbers, separated by a hyphen, as in 5-8 to print
pages 5, 6, 7, and 8. Or, you can list individual pages,
separated by commas, as in 4,8,11 to print pages 4, 8,
and 11. And, you can combine ranges and individual pages,
as in 4,9-11,13 to print pages 4, 9, 10, 11, and 13. Use the
Pages box to specify the pages you want to print. Entering page numbers in the Pages box automatically changes
the drop-down list setting to Print Range if it wasn't already so.
Document Properties: Print information about your document.
List of Markup: Print a list of revisions made to the document.
Styles: Print the styles in the document.
AutoText Entries: Print any AutoText entries in the document.
Key Assignments: Print any custom shortcut keys that
are assigned.
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Print Markup: You can enable the Track Changes feature and then use this option to print your document along
with any revision marks.
Only Print Odd Pages: Print pages 1, 3, 5, and so on.
Only Print Even Pages: Print pages 2, 4, 6, and so on.
Other settings
The Print page of Backstage view has several other
options:
Print One Sided: Most printers print on only one side of
the paper. This option lets you manually print on both sides
of the paper, if you want. If you choose to print manually
on both sides of the paper, Word prompts you to reinsert
each page to print the next page on its backside.
Collated: This option is useful when printing multiple copies of a document.
Portrait Orientation: Portrait orientation refers to printing on the paper so that the longest side of the paper is
the height and the shorter side is the width. Landscape
orientation flips the page so that the long side is the width
and the short side is the height.
Letter: Change the paper size. The default is usually Letter (8.5 x 11), but you can select different paper sizes.
Margins: You can change the margin settings from the
Print page.
1 Page Per Sheet: Print more than one page on each
sheet of paper.
Page Setup: This hyperlink near the bottom of the page
opens the Page Setup dialog box, from which you can
adjust the document margins again before you print
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Travel, Tourism & Hospitality
Related Theory for Exercise1.3.01
Secretarial Practice (English) - Speed enhancing techniques in SH and practice on
computer

The Circle: Small circle for S & Z, Circle and the strokes, Circle S with H
Stroke, Stroke L and circle S
Objectives: At the end of this lesson, you shall be able to
• define small circle of S & Z
• explain when the circle is not used
• describe the small circle S with H
• express the L stroke with circle S.
Circle - S
The consonant sounds S and Z are represented not only by the strokes S and Z but also by a small circle - o. Initially the
small circle represents the sound of S only and medially, finally the sound of S or Z. The circle is written
a. Inside the curves as in,

b. Outside the angles formed by two straight strokes joined together as in

c. With left motion (anti-clockwise) to straight strokes, as in

d. Initial circle is read first and final circle is read last. Vowels are read in relation to the stroke, not to the circle.
e. Circle S may be added to grammalogues and short forms to get derivatives of words, as in

Circle and the Strokes
Stroke S is used when it stands alone or when it is preceded by a vowel initially or followed by a vowel finally, as in

However, the stroke S is written finally to represent "-ous" when preceded by a diphthong/ diphone sound, as in
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Stroke Z is used initially and finally when followed by a vowel, as in

Circle before aspirate H
Initial sound of S followed immediately by H is represented by doubling the attachment (circle) of H. The rule of upward
and downward H should be followed when initial S is immediately followed by H, as in

But the sound of SH is always represented by its stroke, as in

Stroke L and Circle S
Stroke L immediately followed or preceded by a circle attached to a curve, is written in the same direction in which the
circle is completed, as in
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.3.02
Secretarial Practice (English)- Speed enhancing techniques in SH and practice on
computer

Computer speed typing: Speed calculation, Signs and Symbols, Roman
Numbers, Capitalization of Letters, Display, Counting Errors and calculating speed and errors, Evaluation & Marking Scheme
Objectives: At the end of this lesson you shall be able to
• state the formula for calculation of speed
• state the nature & treatment of errors
• state the evaluation scheme
• understand the formula for calculation of net speed.
Calculating speed on computer

(f)

Various methods of calculating Gross Speed, Net Speed,
and Assignment of marks are being used. Best formula
has been evolved for counting of Gross speed, Net speed
and assignment of marks on the basis of minimum speed
prescribed. 5% errors are allowed.

Errors Admissible (EA) = 5% of Gross Words Typed, e.g.
GW 300 = 15 WORDS.

Counting of strokes
5 Strokes constitute a word. In counting of strokes or letters, every depression of a key is counted, including shift
key, tabulator bar, and space bar for leaving space between words. In this method the penalty for each error is 2
words which is universally prescribed limit. Before any
calculation is done mark the error in the typed script and
write the gross letters typed. Note the duration of the test
GROSS SPEED

GS = GL/5T (WPM)

GS= Gross speed GL= Gross Letters

T= Time

NET SPEED GL-PE/5T
PE = Penalty for errors (10 x Errors) 5 = (5 Strokes= 1
word)
Nature & Treatment of Errors
Overtyping of letter, wrong or non-use of punctuation marks,
wrong or non-capitalization of a letter, spelling mistake,
addition of any letter, typing of a figure forward or vice
versa, leaving no space between different words, wrong or
non-syllabification or words at the end of a line.
Evaluation Scheme

PE for Penalty for Errors.

Formula for Calculation of Net Speed
Net Speed = GW (Gross Words) - PE = …w.p.m (words
per minute) T (Time)
A. Example 1 -If GW is = 300; EC = 15 ; The Net Speed
Calculation will be:
Net Speed = GW (300) - PE (2x5) = 300 -0 = 30 wpm
Time (10)

10

B. Example 2 -If GW is = 300; EC = 20 ; The Net Speed
Calculation will be:
Net Speed = GW (300) - PE (2x5) = 300 -10 = 29 wpm
Time (10)

10

C. Example 3 -If GW is = 300; EC = 30 ; The Net Speed
Calculation will be:
Net Speed = GW (300) - PE (2x5) = 300 -30 = 27 wpm
Time (10)

10

A. Marks Obtained = Maximum Marks(100) x Net Speed
(30) - QPM (40) =Marks
Qualifying Speed (30)

Test of computer

M.O. = MM(100) x NS(30) - QPM(40) = 60 Pass

e.g. Speed Test (English) @ 30 WPM

QS(30)

Max. Marks Allotted = 100
(a)

Qualifying Speed =30 wpm; Time = 10 Minutes

(b)

Qualifying Marks (QM) = 60% of MM (100) =60

(c)

Qualifying Penalty Marks (QPM) = MM - QM (10060=40)

(d)

Marks Obtained (MO) = on applying the formula
given ahead.

(e)

Error Committed = Gross Error - Error Admissible.

100

B. M.O. = MM(100) x NS(29) - QPM(40) = 56 Fail
QS(30)

100

C. M.O. = MM(100) x NS(27) - QPM(40)= 50 Fail
QS(30)
D. M.O. = MM(100) x NS(40) - QPM(40) =
(if type speed increases)
QS(30)
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Computer keyboard signs & symbols
Key/Symbol

70

Explanation

Windows

PC keyboards have a Windows key that looks like a four-pane window.

Command

Apple Mac computers have a command key.

Menu

PC keyboards also have a Menu key that looks like a cursor pointing to a menu.

Esc

Esc (escape) key.

F1 - F12

Information about the F1 through F12 keyboard keys.

Tab

Tab key.

Caps lock

Caps lock key.

Shift

Shift key.

Ctrl

Ctrl (control) key.

Fn

Fn (function) key.

Alt

Alt (alternate) key (PC only; Mac users have Option key).

Spacebar

Spacebar key.

Arrows

Up, down, left, right Arrow keys.

Back Space

Back space (or Backspacer) key.

Delete

Delete or Del key.

Enter

Enter key.

Prt Scrn

Print Screen key.

Scroll Lock

Scroll Lock key.

Pause

Pause key.

Break

Break key.

Insert

Insert key.

Home

Home key.

Page up

Page up or pg up key.

Page down

Page down or pg dn key.

End

End key.

Num Lock

Num Lock key.

~

Tilde.

`

Acute, back quote, grave, grave accent, left quote, open quote, or a push.

!

Exclamation mark, exclamation point, or bang.

@

Ampersat, arobase, asperand, at, or at symbol.

#

Octothorpe, number, pound, sharp, or hash.

£

Pound Sterling or Pound symbol.

•

Euro.

$

Dollar sign or generic currency.

¢

Cent sign.

¥

Chinese/Japanese Yuan.

§

Micro or Section.

%

Percent.

°

Degree.
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Key/Symbol

Explanation

^

Caret or circumflex.

&

Ampersand, epershand, or and symbol.

*

Asterisk, mathematical multiplication symbol, and sometimes referred to as star.

(

Open parenthesis.

)

Close parenthesis.

-

Hyphen, minus or dash.

_

Underscore.

+

Plus.

=

Equal.

{

Open brace, squiggly brackets, or curly bracket.

}

Close brace, squiggly brackets, or curly bracket.

[

Open bracket.

]

Closed bracket.

|

Pipe, or, or vertical bar.

\

Backslash or reverse solidus.

/

Forward slash, solidus, virgule, whack, and mathematical division symbol.

:

Colon.

;

Semicolon.

"

Quote, quotation mark, or inverted commas.

'

Apostrophe or single quote.

<

Less than or angle brackets.

>

Greater than or angle brackets.

,

Comma.

.

Period, dot or full stop.

?

Question mark.

Roman Numbers
The Roman Numerals are represented by the letters that
we have. The Roman numerals 1-10 are: I, II, III, IV, V, VI,
VII, VIII, IX, X. The Romans used this for their numbers.
Some were influenced by Latin. We use Roman numerals
too. Some books use Roman numerals instead of our regular numbers.
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English Capitalisation Rules
1 Capitalise the first word of a sentence
2 Capitalise Names and other Proper Nouns
3 Don’t capitalise after a colon
4 Capitalise the first word of Quote
5 Capitalise Days, Months, and Holidays but not Seasons.
6 Capitalise most words in Title
7 Capitalise Cities, Countries, Nationalities and Languages
8 Capitalise time periods and events.
Computer Display
A computer monitor is an output device which displays information in pictorial form. A monitor usually comprises the
display device, circuitry, casing and power supply.
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.3.03&04
Secretarial Practice (English) - Speed enhancing techniques in SH and practice on
computer

Large circle, Loops
Objectives: At the end of this lesson, you shall be able to
• indicate large circle for SW, SS, SZ
• state the uses of large circle medially and finally
• explain large circle and its vowel places.
A Large or big circle represents the addition of SW/SS/SZ to the strokes, according to the following rules:
SW Circle
If the circle is enlarged and joined initially with a stroke (inside curves and with left motion to straight strokes), it
represents the double consonant SW, as in

But "SW" cannot be joined with W, Y, H strokes because of initial attachments, as :

SS/SZ Circle
Medially or finally the large circle represents SS/SZ, as in

Large Circle and the vowels: A first or third place vowel can be indicated inside the large circle, as in

Plurals and Possessives: Plurals and possessives can be indicated after the stroke, as in

Two sounds of S-S are represented by S circle and stroke, as in

Small Loop for ST/SD
An oval shaped circle is called a Loop and represents the addition of ST/SD or STR to the stroke, according to their rules.
a) A small initial loop equal to one third of the length of the stroke, attached to straight strokes (except W/Y/H) with left
motion and inside curves, represents the addition of ST to the stroke initially, as in.
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b) The loop represents addition of ST or SD to the stroke finally, as in

c) The loop is also employed medially, as in

But the loop cannot be employed when a vowel follows T or D finally or occurs between S and T/D, as
in

Large Loop - STR
If the size of ST loop is increased to two-thirds of the length of a stroke and, joined medially or finally, it represents STR,
as in

But STR loop is not employed initially with any stroke.
Phrases
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.3.05
Secretarial Practice (English) - Speed enhancing techniques in SH and practice on
computer

Initial small hooks (Double Consonants): R & L Hooks, SHR & SHL hooked
strokes, Vowels and double consonants
Objectives: At the end of this lesson, you shall be able to
• define the initial small hooks for R & L
• explain SHR & SHL hooks
• describe the placement of vowels to double consonants
• state the extended use of R/L hooks.
R Hook to Straight Strokes
A small initial hook written with right motion (clock-wise) adds R to straight strokes, as in

To curved strokes R hook is written inside the curves, as in

L Hook to straight Strokes
A small initial hook written with left motion (anti-clockwise) adds L to straight strokes, as in

L Hook to Curved Strokes: L hook is a large hook written inside the curves, as in

The stroke
(ray) is not hooked initially because the strokes
employed for W and Y sounds.

W and

Y are

SHR and SHL
SHR is always written downward while SHL is always written upward, as in

Vowels and Double Consonants
Vowels are read with the double consonants according to their places, as in

Extended use of R and L Hook
In order to obtain easier joining, L hook is employed in many cases, even though it is followed by a vowel, as in
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.3.06 & 07
Secretarial Practice (English) - Speed enhancing techniques in SH and practice on
computer

Alternative forms of curved hooked strokes, Left & Right Curves of fr/vr/thr/
THr, upward SH with hooked strokes, Intervening vowels, circles and hooks.
Compound consonants: Initial large hooks of WH/WHL/KY/KW/GW/MP/MB
strokes
Objectives: At the end of this lesson, you shall be able to
• illustrate alternative forms of curved hooked strokes
• explain upward SH with hooked strokes
• express intervening vowels for hooked strokes
• explain the S circle and hooks
• describe the compound consonants.
The curves of F, V ith and THEE when joined with R & L hooks form two curves called the Left and the Right curves written
according to their motions.
Left and Right Curves
The left curve is used when a vowel precedes and the right curve is used when a vowel follows.

However, initially the left curve of fl is used as in

But when joined to other strokes the convenient curve should be used, as in

Use of Upward SH with hooked strokes
The stroke SH is written upward before K/G initially hooked; and after certain down strokes; as in following cases:

Intervening Vowels
An initially hooked stroke (pr,kr,chr, etc.) can also be used even when a vowel occurs between the stroke and the L/R
hook. If it is a dot vowel, it is indicated by a small circle (o) either after or before the stroke, thus,

An intervening dash vowel/diphthong is indicated by writing the sign through the stroke, as in
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If it is not possible to write through the stroke, it is placed at the beginning for a first place vowel or at the end for a
third place vowel.

The hooked stroke should not be used in monosyllabic words when a vowel intervenes between the hook and the stroke.

S Circle and Hooks
Circle S/SW/ST before straight strokes hooked for ‘R’ can be expressed by writing them in the place of R hook (with
the right motion), as in

Compound Consonants
When two consonants immediately follow each other, they are called compound consonants. Compound consonants
are represented in shorthand in the following manner.
Formation of compound consonants
Letters

Primary
Stroke

Added
Letter

Added Sign

KW

k+w
= kw

Large
initial hook

GW

g+w
=gw

Large intial
hook

WH

w+h
=wh

Initial hook
enlarged

w+l
= wl

WL

WHL

LR

RR

MP/MB

Compound
stroke

Explanation
Large initial hook written with left
motion to ‘k’ or ‘g’ represents addition
of ‘w’; thus ‘kw’ ‘gw’

(up)

The hook of ‘w’ is enlarged to
represent ‘wh’.

Small
initial hook

(up)

Small initial hook inside L represents
the addition of ‘w’; thus ‘wl’.

wh+l
=whl

Large
initial hook

(up)

Large initial hook inside ‘l’ represents
the addition of ‘wh’; thus ‘whl’.

l+r
= lr

L is thickened
(down)

‘L’ is thickened to represent the
addition of ‘r’; thus ‘ler’. It is always
written downward.

(down)

‘R’ is thickened to represent the
addition of ‘r’; thus ‘rer’.

r+r
=rr

R is thickened

m+p
=mp/
m+b
=mb

M is
thickened
for addition
of p or b

‘M’ is thickened to represent ‘mp’ or
‘mb’.
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A large initial hook with left motion to the strokes ‘k’ or ‘g’, adds ‘w’ and forms compound consonants. The compound
consonants ‘kw’ or ‘gw’ can be used initially, medially and finally; thus,

A small circle may be prefixed to ‘kw’; thus,

Circles, loops or any attachments may be added finally to ‘kw’ or ‘gw’; thus,

The compound consonant of ‘kw’ is not used in words like

equality, etc., where a clear outline cannot be obtained by writing ‘kw’.
When the sounds of ‘w’ and ‘h’ occur together i.e., ‘wh’, the initial hook of ‘w’ is enlarged to represent the compound
consonant of ‘wh’. Final attachment can be added to ‘wh’. However, ‘wh’ does not occur finally; thus,

whip,

wherein,

nowhere

whisky,

whistle.

A small initial hook written inside the stroke upward ‘l’, prefixes ‘w’ and forms a compound consonant ‘w+l’, which is
used initially, medially and finally; thus,
well,

woolly,

weldon,

welcomer,

wealth,

unwell

Final attachments of circles, loops or hooks are added to ‘wl’; thus,
well,

wills.

A large initial hook written inside the stroke upward ‘l’, forms a compound consonant ‘wh+l’, which is used initially, and
finally; thus,
wheel,
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whelm,

whaler,

while,

,meanwhile
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Final attachments of circles, loops or hooks may be added to ‘whl’; thus,

When a word begins with vowel and followed by ‘wl’, ‘whl’, the outline is to be written fully; thus,

The downward ‘l’ is thickened for the addition of ‘r’ and thereby represents the compound consonant of ‘lr’. The vowel
between ‘l’ and ‘r’ is generally unaccented. Short vowels ‘e’, ‘a’, ‘u’, etc. generally occurr between ‘l’ and ‘r’ in the end
of spellings –lar, -ler, -lour, -lor, thus,

A small circle can only be attached finally to the compound consonant ‘lr’; thus,

When a strongly sounded vowel occurs between ‘l’ and ‘r’, strokes ‘l’ and ‘r’ are to be used;

When a vowel follows final ‘lr’, stroke ‘l’ and ‘r’ are to be used; thus,

The stroke ‘m’ is thickened to add ‘p’ or ‘b’ and thereby represents the compound consonant ‘mp’ or ‘mb’ and this shall
be used to represent ‘mp’ or ‘mb’ without a vowel between them, initially, medially and finally; thus,

The initial attachments of circles, loops, hooks or tick ‘h’ arc attached to the compound consonants ‘mp’ or ‘mb’, in the
same manner as they are attached to other curves; thus,

Finally, attachments of circles, loops or hooks may be added to ‘mp’ or ‘mb’; thus,

The compound consonant of ‘mp’ or ‘mb’ is not used when a vowel occurs between ‘m-p’ or ‘m-b’; thus,

‘mp’ or ‘mb’ is not used when ‘m’ is followed by ‘pr’, ‘br’, ‘pl’, ‘bl’ and should be written with stroke ‘m’ and hooked form;
thus,
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.3.08&09
Secretarial Practice (English) - Speed enhancing techniques in SH and practice on
computer

Final Hooks: N & F/V small hooks, hooks and vowels, circles and loops with finally hooked
strokes, SHUN hook
Objectives: At the end of this lesson, you shall be able to
• explain final hooks (N, F/V)
• state when hooks are not used
• express circle & loops with final hooks
• state large final hook shun
• describe shun hook after circle and strokes.
Final Hook - N
To Straight strokes
A small final hook attached to a straight stroke with right motion (clock wise) represents the addition of ‘n’ to the stroke.
as in

To Curved Strokes: N Hook is written finally inside the curves as in

F/V Hook
A small hook written with left motion to straight strokes represents the addition of F or V to the stroke, as in

F/V cannot be expressed by hook with curved strokes and is written by the stroke, as in

Hooks can be employed medially whenever clear outlines are obtained, as in

Final Hooks & Vowels
Final hooks are not used if a vowel follows N/F/V, as in

Termination - NER
The termination "ner" is written according to facility (N hook+downdard R), or by hooked ‘n’

80
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, as in

Use of Circle & Loops with Final Hooks
S, SES, ST, SD or STR is added to N attached to a straight stroke by writig the circle or loop on the same side as the
N hook.

S Circle gives Z sound when placed inside the F/V and N hooks to indicate plurals or singular verbs, as in

The sound of NS and NZ should be distinguished by using the hooks and the strokes, as in

Large Final Hook - SHUN
If the final hook is enlarged, it represents the sound of Shun. The hook can extend upto ¼ of the length of a stroke.
A large final hook attached to straight strokes on the opposite side of a vowel or diphone/triphone and inside curves adds
-SHION, -TION, -CIAN, -SION, -TIAN, -SIAN to the strokes, as in

This hook is written on the opposite side of a circle or hook attached to the stroke, as in

This hook is written on the opposite side of F, V & L curves followed by K/G to maintain the straightness of K/G, strokes
as in

This hook is written on the right side of CH, J, T, D strokes to facilitate easy joining, as in

SHUN Hook after circle and strokes
Shun after circle is represented by a small curl (continuation of the circle). A third vowel can be indicated outside the curl,
as in
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.3.10-12
Secretarial Practice (English) - Speed enhancing techniques in SH and practice on
computer

Halving Principles: Halving of Strokes for T or D, Halving of M,N,L,R for D,
Halving of hooked MP/MB/NG, etc.
Objectives: At the end of this lesson, you shall be able to
• explain halving - for T & D
• state the halving principles for MD,ND,LD & RD
• state the halving principle for MP/MB/NG
• explain grammalogues /contractions/phrases related to the halving principle.
In Shorthand it looks strange to add something to a consonant stroke by halving it. It facilitates speed and clarity of
outlines.
Halving for T or D
In words of one syllable (stroke) a light stroke without any final hook or joined diphthong can be halved for the addition of
T and a heavy stroke without a final hook or joined diphthong can be halved for ‘D’ only.

Any stroke having a final hook or joined diphthong/diphone can be halved for the addition of T or D, as in

A word having more than one syllable (stroke) can also be halved for the addition of T or D, as in

Halving principle cannot be employed if a vowel follows T or D finally, as in
pit

pity

greed

greedy

goody

Half length strokes initially are written above the line and on the line according to their vowels, but in no case these can
be written through the line, as in

Halving M, N, L, R
M, N, L, R (downward) strokes can be thickened and halved for D, as in
made

need

old

aired

MP/MB, NG
The compound consonant of MP/MB and NG can be halved to represent the addition of T or D when they are hooked
initially or finally, as in
82
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When P/B are not pronounced fully they are represented by halved M stroke, as in

Half sized strokes are sometimes disjoined to get clearcut outlines, as in

RT & LT are written upward when halved for T, but when thick RD is inconvenient, upward R also can be halved (/) to
represent RD as in

Strokes of unequal length can be joined where there is difference in thickness, as in

Strokes of unequal length can not be joined unless there is an angle at the point of junction, so the following words are,
written with full-length strokes.

In past tenses -ted or -ded is always indicated by half - length T or D, as in

Stroke S (Up/Downward) after SHUN hook is halved as in

A word (verb) represented by a single stroke with initial attachment can be halved for its past tense
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Practice the following important Grammalogues /Contractions/ phrases related to the Halving principle

84
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.3.13
Secretarial Practice (English) - Speed enhancing techniques in SH and practice on
computer

Doubling Principles - Doubling of strokes for TR & DR, Doubling of MP/
MB/NG and L strokes, etc.
Objectives: At the end of this lesson you shall be able to
• explain the principles for adding TR/DR/THR/TURE
• explain the doubling principles for MP/MB/NG and L strokes
• describe the grammalogues/phrases related to the doubling principle.
"Doubling the length of any stroke for the addition of -TR, -DR, -THR or -TURE, is called Doubling Principle in
Shorthand".
Doubling for TR & DR
i) The curved strokes are doubled for the addition -TR, -DR, -THR or -TURE, thus

reminder

murder

vender

voter, etc.,

ii) Straight strokes with initial attachment/hook or with a final hook or joined dipthong are doubled for the addition of -TR,
-TR, -DR, -THR, -TURE. Straight stroke following a consonant can also be doubled.

MP/MB & NG
iii) The compound strokes of MP or MB can be doubled for the addition of R only, while NG can be doubled for
the addition of KR/GR, as in

LTR/LDRL/LTHR
i) L when standing alone or with a final circle is doubled for the addition of -TR only

ii) Strokes of unequal length cannot be doubled, as in

iii) The Doubling principle is not employed when a vowel follows final R or when there is inconvenient joining, as in

iv) Past tenses of words written with doubling principle are obtained by halving principle, as in
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Practise the following important grammalogues/contractions/phrases related to the doubling principle
Grammalogues

Character
Culture
Industry
Therefore
Rather (writer)
Cooperative
Wonderful-ly
Speaker

Contractions

Characteristic
Internet
Alternative
Federal
Interest
Inventor
Centralise

Phrases

in order that
rather than
in their
not later than
I am sure there is
if there were
upon their
Private sector
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.4.01&02
Secretarial Practice (English) - Prefixes & suffixes, monetary units & dictation
Prefixes - Definition, use and representative lines
Objectives: At the end of this lesson, you shall be able to
• define prefixes
• describe the strokes used for prefixes
• explain the use of prefixes in grammalogues/contractions and phrases.
Definition
“Part of a word which affects the meaning of another word if put in its beginning is called a prefix”
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Prefix

Explanation
In phraseography
after downward dash logogram,
medial –con dot should be
used, but not after downward
logogram

Examples

should commence
on-the-committe
of-the-committee
to-commence

Accom-or
accommo-

Intro-

The prefix Accom- or
accommo- is represented by
joined or disjoined ‘k’; thus

Accompany

Intro- is represented by joined
double length ‘n’
(ntr); thus

Introduce

Accommodation

Introspect

Magna-magnemagni

The prefix magna- or magne or
magni- is represented by
disjoined ‘m’; thus

Magnanimous
Magnetise
Magnificent

Trans -

The prefix ‘trans’ - is
represented by joined ‘trs’ i.e.,
by omitting ‘n’, thus
In some cases full outline is
written to obtain clear outline;

transfer
transmission

transact
transcend

Self -

Self-con,
Self-com

Self- is expressed by a
disjoined small circle written
close to the following stroke in
the second place; thus
Self-con, or self-com is
represented by a disjoined
small circle placed in the
position of con- dot; thus

self-made
self-reliance

self-control,
self - contained
self - confident

88

Travel, Tourism & Hospitality: Secretarial Practice (English) - Related Theory for Ex. : 1.4.01 & 02

Copyright @ NIMI Not to be Republished

Travel, Tourism & Hospitality: Secretarial Practice (English) - Related Theory for Ex. : 1.4.01 & 02

Copyright @ NIMI Not to be Republished

89

Grammalogues
Selfish-ness

inscription

instruction

instructive

Phrases
foundation-stone

all-parts-of-the-world

Ladies and
gentlemen

that-was

at-the-same-time

in-the-courseof-your

for-some-time

we-are-able-to

at-some-time

according-to-the

Contractions
relinquish-ed

remarkable-ly

removable

represent-ed

republic

republican

responsible-ly

sensible-ly-ility something

substantial-ly

sufficient/ly/cy

unanimous-ly

uniform-ity-ly

university

whatever
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telegram

universal-ly

whenever

representation

telegraphic

universality

whensoever

unanimity

universe

whereinsoever
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.4.03&04
Secretarial Practice (English) - Prefixes & suffixes, monetary units & dictation
Suffixes: Definition, use and representative lines
Objectives: At the end of this lesson, you shall be able to
• define suffixes
• illustrate various suffixes.
Definition
"The Part of a word which affects the meaning of another word if joined at the end, is called a Suffix. Suffixes are
represented by the following strokes or signs".
The following tables explains you the employment of suffixes in shorthand
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Suffix

Explanation

-ings

Wherever –ing is represented
by dot, -ings is represented by dash

-ing is not
used medially

The dot –ing cannot be used
medially and hence stroke
is to be used; thus

Examples

Terminations
-ality, -ility,
-arity, -ority,
-elty and
similar
terminations

-ality, -ility, -arity, -ority, -elty and
similar terminations are expressed
by disjoining the stroke occurring
just before the termination; thus

In a few cases, full form is
written to obtain more distinct
outlines; thus

-logical and
-logically
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- Logical and -logically are represented
by disjoined ‘j’ / thus
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Suffix

Explanation

Examples

-ment

-ment is generally represented
by
-mnt. Where this form
of
-mnt is not convenient to
join, the termination –ment is
represented by
nt; thus

-mental
-mentally
-mentality

-mental, -mentally, and
–mentality are expressed by
disjoined mnt; thus

-ly

-ly is expressed by joined or
disjoined ‘l’ and in some
cases with hook ‘l’ also; thus

-ship

-ship is expressed by a joined
or disjoined ‘sh’ ; thus

-fullness

-fullness is represented by
disjoined ‘fs’
; thus

-lessness,
-lousness

-lessness and –lousness are
represented by disjoined
thus

-ward, -wart, wort

-ward, -wart, -wort
are expressed by joined half-length
‘w’
; thus

-yard

-Yard is represented by joined
half-length ‘y’
; thus

‘ls’;

.
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The compound words beginning with here; there, where, etc., are written as follows
herein

wherein

therein

hereon

whereon

thereon

hereat

whereat

thereat

hereto

whereto

thereto

hereof

whereof

thereof

herewith

wherewith

therewith

Logograms used as suffixes
The following logograms, joined or disjoined, may be used as suffixes; thus

outbalance

free-trade

armchair

recalled

overbalance

over-trade

out-general

forgive

self importance self improvement
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rebuild

indifference

become

misgiving

underhand

outnumber

foretell

disadvantage

bedchair

outcome

overcome

safeguard

vanguard

landlord

underwriter

untried
ungentlemanly
unequal-ly
un-thinking
un-schooled
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.4.05
Secretarial Practice (English) - Prefixes & suffixes, monetary units & dictation
Intersections-Monetary units and round figures
Objectives: At the end of this lesson, you shall be able to
• state the definition of intersection
• explain various intersections used in speed writing
• state monetary units and round figures in shorthand.
Definition
"Cutting of one stroke by the following stroke to represent a word in common phrases is called intersection".
Some Official |Colloquial| Phrases using intersections
Commonly occurring words are represented in official phrases by intersection or disjoining the following strokes, thus :
STROKES

K stroke represents the words "Council", “captain”,
“Capital” and “Company”

WORDS

SIGNS

Research Council
Captain Cook
Share capital
Carriage company

CH stroke represents "Chancellor", as in

Vice Chancellor

Acting Chancellor

University Chancellor

Chancellor of Exchequer

J stroke represents "Journal", as in

School Journal

Medical Journal

Journal of Education
Weekly Journal
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STROKES

WORDS

T stroke represents "attention" as in

SIGNS

Early attention
Special attention
Calling attention

Government's attention

D stroke represents "Department", as in

Revenue Department

Finance Department .

Health Department

Medical Department
Professor Ramu

‘PR’ represents professor

Professor of Biology

‘KR’ represents Corporation

Tiruchi Corporation
Corporation of Madurai

‘G’ represents Government

Government of India
Government official

‘Ray’ represents require/required/requirement/railway

do you require
if he required
to meet the requirements

railway ticket
96
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STROKES
‘Ar’ represents arrange/arranged/arrangement

WORDS

SIGNS

I shall arrange
it will be arranged
make arrangements

P stroke represents "party", as in

Congress party
Political party
Communist party
Socialist party

B stroke represents -"Bank"-, bill as in

State Bank

Reserve Bank

Bank of India

Education bill

TH stroke represents "authority", “month” as in
Government's authority

District authorities

for a month

many months ago
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STROKES
S stroke represents -"society"-, as in

WORDS

SIGNS

Co-operative society

Housing society

Education society

Registrar of societies

N stroke represents -"national"- and -"inquiry"-, as in

International

Anti-national

National disaster

National revenue

L stroke represents "limited", as in
Private limited
Fertilizers limited

It also represents ‘liberal’ as in

Liberal policy
liberal view
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Round Figures
Figures are generally written with numbers, but Round Figures can be represented with disjoined strokes, thusSTROKES
Stroke B represents the word "billion", after figure (numbers),as in

WORDS

Signs

5 billion
3 billion
10 billion

Stroke TH represents "thousand" after figures (numbers), as in

Four thousand
Six thousand
50 thousand

Stroke N represents "hundred" after figures, as in

12 hundred
5 hundred
100
200

Stroke M represents "million" after figures, as in

5 million
200 million
600 million

Stroke KR represents "crore" after figures, as in

6 crores
12 crores
12,000 crores

Stroke L represents "lac (lakh)" after figures, as in

2 lacs
50 lakh
9 lacs
60 lacs
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Monetary Units
The principle Monetary Units are represented by their sound strokes after/before round figures, thus
STROKES
Stroke Rs represents "rupees" before round figures, as in

WORDS

Signs

Rs. 200
Rs. 2000
Rs. 300
Rs. 260

Stroke PNS (halved) represents £ (pounds) after figures, as in

300 £ (pounds)
2000 £ (pounds)
50 £ (pounds)

Stroke D represents "dollar" after figures, as in

1000 dollars
250 dollars
300 dollars

100
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Monetary Units & Round Figures
Figures
Figures in shorthand are represented in the following way. The figures one to seven and nine are represented by shorthand outlines, when standing alone. Other numbers, except round numbers are represented by the ordinary Arabic
numerals.
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.4.06 & 07
Secretarial Practice (English) - Prefixes & suffixes, monetary units & dictation
Contractions - Formation and uses - Essential vowels and Contractions
Objectives: At the end of this lesson, you shall be able to
• explain how contractions are formed.
• state the different contractions and their derivatives
• understand the importance of contractions in speed writing.
Contractions are formed in the following ways:
1 Using the first two or three consonants
2 Omitting a medial consonant or syllable(s)
3 Based on a shortform
4 By intersecting strokes
5 Omitting the first syllable
A contraction is defined as a shorthand sign containing not less than two strokes, in which one or more of the consonants of the word are not represented (omitted).
Difference between contraction and a grammalogue: A contraction is a shorthand sign containing not less than two
strokes and formed by omission of one or more strokes in the outline either medially or finally, whereas a
grammalogue is a word represented by a single shorthand sign called logogram.
Omission of Consonants

102
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Contractions
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Related words
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Contractions
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Related words
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Contractions
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Related words
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Contractions
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Related words
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Contractions

112

Related words
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Essential Vowels
Vocalized Outlines. There are certain word outlines which should be vocalized to some extent, according to the following rules:
(a) In single stroke outlines having an initial and a final vowel, the final vowel should be inserted; thus:

(b) An outline should be written in position notwithstanding that it has an initially or a finally joined diphthong-sign; thus:

(c) Where an upward or a downward ‘r’ does not indicate a preceding or a following vowel, the vowel sign should be
inserted: thus;

(1) Insertion of an initial vowel
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(2) Insertion of medial vowel

(3) Insertion of a final vowel
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Special Contractions
A Contraction is an abbreviated word having more than one stroke. Simple Contractions are formed by prefixing or
suffixing strokes, circles, etc. to logograms or grammalogues. The other forms are Special Contractions formed by
omitting the less spelt sound-strokes, or inconvenient strokes for easy and speedy writing. Special contractions are
generally written on the line. However, third vowel sounding contractions should be written through the line for easy
reading and clarity. No vowels are put on the contractions, as in
PART A

116
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.5.01-03
Secretarial Practice (English) - Proficiency in note-taking and transcription on
computer

Evaluation Scheme and Letter writing techniques
Objectives: At the end of this lesson you shall be able to
• evaluate shorthand practical test
• explain the formula for award of marks
• differentiate personal & Business Correspondence
• explain basics of official Correspondence.
Evaluation Scheme - shorthand practical test
Treatment & Penalty for Errors
Errors Committed to be Marked on the Script and counted as
Full/One Error to be marked by X sign on the script for the following types of Errors
a. Omission/ addition/ substitution/ transposition of any Word or figure
Spelling Error of a word (Spell check facility being available on Computers)
b. Half Error to be marked by an oval sign for
•

Non-capitalization of Proper Nouns or wrong capitalization of first letter of a sentence (in English
Shorthand Transcription only);

•

Spelling error of Proper Nouns (unpopular names or places, etc.);

•

Wrong or non use of Punctuation Marks.

•

Maximum 1 Error should be marked for repeated spelling errors of a word.
No Errors should be marked for improper paragraphing

c. Total Errors = Full Errors + ½ of Half Errors;
d. Fraction of an error to be ignored and rounded off to the nearest figure. Marks to be awarded on Full
Errors (e.g. round figures).
Shorthand Dictation Gross Speed = Total words/ Time
Formula for award of marks
5 Minutes Shorthand Tests @ 80 WPM and transcription on computer in 45 minutes:
Details of Examination Scheme:
(MM) Max Marks allotted = 100Qualifying Marks = 60% of MM() = 60
(a) Total Words dictated @ 80 w.p.m. for 5 minutes

= 400 words

(b) Errors Admissible =Maximum 5% of total words (400) = 20 (EA)
(c) Errors Committed (Errors committed by the candidate) = Total/Actual Errors
(d) Qualifying Marks (60% of Max. Marks 100)

= 60 (QM)

(e) Qualifying Penalty Marks (MM (100) - QM (60)

= 40 (QPM)
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Formula
Marks Obtained (MO) =

MM (100) - EC x QPM (60)
EA (20)

Examples 1 - A candidate committing 25 Errors will get = 100 - 25(EC) x40(QPM)

=

20(EA)
Examples 2 - A candidate committing 20 Errors will get = 100 - 20x 40

50
100

=

20
Examples 3- A candidate committing 10 Errors will get = 100 - 10x 40

100
=

20
Examples 4 - A candidate committing 0 Errors will get = 100 - 0 x 40

Letter writing is the most important work of a Stenographer in any office. Therefore the art of taking dictation
from the officer and typing it on the mechanical or electronic typewriter or a Personal Computer is the first and
foremost task of a Stenographer. The Stenographer has
to deal with all types of correspondence, e.g. personal,
official and business letters on various topics.
Simple Letter Writing
Letter writing or typing is the most effective means of communication in which the steno/Typist/computer operator
plays an important role. Majority of the written communication between individuals, professionals, business
houses, companies, organizations, public undertakings,
Government Departments, etc. is done in the form of letters because it is the legal and cheapest system of communication. If a letter is properly drafted and beautifully
typed, it becomes attractive and impressive at the hands
of the receiver and carries more weight. Therefore, before
taking the dictation of letter the understanding of the various formats is necessary for typing of letters. Therefore,
this is an important function of the Stenographer in any
office. It is the responsibility of the stenographer to type
the letter with accuracy and proper display keeping in view
the size or the subject matter of the letters. He should
understand the formal formats of correspondence generally used in an office to take the dictation and transcribe
the same properly.
Letters are broadly classified into three categories
1 Personal letters
2. Business letters,
3 Official Letters.
Letters are written or typed in two ways i.e., formal and
informal. Personal or Private letters are informal, while
Business or Official letters are formal in nature. Informal

80
100

=

20
Letter Writing

60

100
100

letters are letters of personal interest exchanged between
friends and relatives. No set norms are prescribed for
typing informal letters. But formal letters have to follow a
set pattern or format according to its nature.
Important Parts of the letter
All the letters whether personal or business contain the
following essential details:
• Name of the sender or firm;
• Reference number and date;
• Name and address of the recipient (address)
• Salutation (Sir, Dear Sir, Dr., Mr., Dear..);
• Subject heading and Subject matter;
• Complimentary closure or subscription, viz. Thanking
you, With regards, Yours;
• Name and signature of the sender;
• Enclosures, etc., or post-script (if something is to be
added at the end of the letter)
A Personal correspondence
Personal Correspondence is done between two friends,
relations etc. concerning any personal or private work.
Application for a post by an individual is also called a
personal letter. But the appointment letter from a company or firm or a letter dealing with the application is a
business letter. In the personal letters, any style of typing
can be used. Name of the sender and the addressee must
be used. Name of the sender and the addressee must be
given. Salutation depends upon the intimacy or relationship between them. The subject matter is written in a personal or natural way. Complimentary closures also depend upon the friendship or relationship, age, etc. Below
the complementary closure, name and the signature of
the sender is given.
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B Business correspondence

D. O. Letter

Business letters are written between two firms, companies, or individuals concerning any business. In business
letters, details of the firm, its address, telephone, etc.,
are given. Business letters are formal in nature. Therefore,
reference number, date, etc. are also given. All the parts
of the letter are written. Business letters are mild, polite,
business like. But there are no set norms to be strictly
followed like official letters. Business letters can be typed
in blocked, indented or semi indented methods.

Demi-Official (D. O.) letter is the official communication
between two officers of different Departments / Ministries
/ Undertakings, etc. It is written like a personal letter. Reference No. is written as D.O. No.............The D.O. letterhead is printed in different forms in which the name of the
sender and his designation is written on the left hand
margin at the top. The salutation is written as "Dear
Shri....."My dear Mr...." "My dear...". Complimentary closure is written as "Yours sincerely", or "Sincerely yours".
But in the Official letter "Yours faithfully" is written. The
designation of the signing authority is not repeated at the
end of the letter, but only name is written. The name and
address of the addressee is written on the left side after
the signature line.

Public Notice
Notice published in papers giving information to the public
regarding business is also treated as Business Correspondence. These include, Company Notices, Tender Notices,
Auction Notices, Public Notices, Advertisements, etc.
However, Notices dealing with legal matters are treated
as Official Correspondence. These are issued on behalf of
the Government Departments / Statutory Bodies, Public
Undertakings, Autonomous / Local Bodies.
C Official correspondence
Official letter is a communication between two offices of
the Central/ State Government /Statutory Body /Public undertaking. Letters written from these organizations to the
individuals or employees are also called official letters.
These can be written in the following forms:
•

Simple official letter /Circular

•

Demi- Official letter

•

Office Memorandum

•

Notification/ Press Release

•

Unofficial Note

•

Office Order

•

Endorsement

•

Footnote

Office Memorandum
This form of letter is generally used for subordinate officers and employees asking for explanation, etc. In this the
'To' address is given on the left side with blocked paragraph. No salutation is necessary.
Notification
Notification is issued to notify the promulgation of any
Ordinance, Statutory Rules, Appointments, Promotion,
Grant of Leave, Suspension, Dismissal or Retirement Orders of any Gazetted Officer of the Government. All the
Notifications are published in the Official Gazette. Notifications of public interest are also published in the newspapers, i.e., Revision of Voters' List; Election to any post,
Nomination of Candidates to various posts, etc. as given
below.
Unofficial (U. O.) Note
Unofficial Note is written by one Department to the other
to seek advice, comments, clarifications, etc. on files or
on separate note-sheets. No salutation is given in this
form of communication. However, Reference No., Name
and Designation of the sender and the addressee is given.

Official letter contains mainly the following parts:

Office Order

•

Reference No. of the letter

•

Name of the office/Dept./ Ministry/Organisation

•

Official address of the sender

•

Address of the recipient

Office Order is used for issuing instructions for grant or
cancellation of leave, advances, distribution of work,
transfer, posting, etc. of employees. No salutation or complimentary closure is given in Office Orders. Copies are
endorsed to the concerned individuals/ sections.

•

Place and Date

Endorsement

•

Subject

•

Salutation

•

Body of the letter

•

Compliments

•

Name and Designation of the sender

•

Enclosure

Endorsement is the copy of a communication sent to the
other Department or individual who may be concerned with
it. If a list of communications is to be sent, the endorsement of this is done as a separate letter enclosing the list
of communication to be sent. Otherwise, normally, the
endorsement is made at the bottom of any communication to the concerned individuals and authorities/ departments.

•

Initials of sender/abbreviations of typist

122

An endorsement is addressed as
"Copy to" -
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Footnote

1, Pitman-2, Shaw-3, Sweet-4.

Footnote is a reference of some document. It enables the
reader to get the source of the document referred to by
the writer. Footnotes are typed at the bottom of the page
on which reference number is given.

1. Dr. G. D. Bist, the first-ever Ph. D. in Stenography.

To separate footnotes from the text, a line is drawn by
underscore. Footnotes are generally typed in single space.
One, two or three footnotes can be indicated by asterisks, but if there are many footnotes, then they are indicated by numbers (figures) typed in a raised position in
the form of super-scripts. The same figure is given before
the footnote after which the footnote manager is typed.
Double or triple spaces are given in between two footnotes to separate them.

2. Sir Isaac Pitman, founder of modern system of Shorthand.
3. George Bernard Shaw, the great Novelist and Essay
Writer and the Writer of Pitman's Shorthand.
4. Prof. Henry Sweet, the Phonetician, critic of Sir Isaac
Pitman.
A few samples are given in the shorthand
practical for taking down dictations and to transcribe them properly. More practice may be
given from available books

Nowadays, footnotes are being given at the end of the
chapter in articles. Books, research theses etc. i. e. Bist-
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Travel, Tourism & Hospitality
Related Theory for Exercise 1.5.04
Secretarial Practice (English) - Proficiency in note-taking and transcription on
computer

Transcription and Note-taking techniques
Objectives: At the end of this lesson you shall be able to
• express note taking techniques
• describe method of shorthand practice
• understand position (places) of outlines
• understand essential vowels
• identify similar outlines with different meanings.
After thoroughly practising the theory and dictation exercises of the book, a student is fully able to take dictations
of simple personal letter; business correspondence and
official communication and transcribe these into English
with proper rules of display about which he/she has learnt.
Now the work of dictation writing and its transcription is a
very difficult task. To write accurate Shorthand is good, to
read Shorthand script correctly is better but to transcribe
it accurately is best which is the ultimate goal of a
Stenographer. For this one has to adopt the most convenient and beneficial methods.

speed writing. This can be done by proper positions of
outlines, of short forms & words, full knowledge of downward/upward strokes, circles, loops, hooks, halving &
doubling principles all of which are vowel elimination
and speed writing devices.
•

Practice short-forms repeatedly daily since more than
70 per cent of these are used in dictations. Write 8 to
12 short forms/phrases in the top line of your notebook
and then repeat them, in the following lines.

•

If you concentrate on outlines in every line, you will
easily remember them by writing 8 to 10 times. In the
same way copy the exercises and read them back
with speed. By this you will improve your outlines and
reading habit. Your vocabulary will increase with more
and more dictations you write. Your spellings will improve with more and more transcriptions.

•

It is better to choose a fellow Shorthand writer for practice, if other aids such as class-room, good teacher,
audio facility, etc. are not available. But be sure that it
is better to have self-learning than to learn from an unskilled teacher.

•

Rectification of Errors is the key to success. After transcribing the Shorthand Dictation do compare it with
your notes to detect omissions and then analyse the
errors of spelling & punctuation e.g. full stop, capitalization of proper nouns, Question Mark, etc. Write the
wrongly spelt words correctly in longhand and Shorthand outlines repeatedly till these are mastered and
not repeated in future dictations/transcriptions. Omissions in writing dictation of words/phrases/short forms
can be improved by repeated practice of the respective
words/short forms/phrases.

•

Thus all these inputs of Shorthand with the proper
mechanical aids of a typewriter / computer will give the
maximum output or assured success in Stenography.

The latest method is Audio Cassette, or self-dictation. Prerecorded cassettes on selected dictation material at various speeds are available. Always write 20 words ahead
of the targeted speed and practise it until mastered.
Turning of pages is an essential practice which helps in
speed and accurate writing.
Note Taking Techniques
More and more dictation, copying and reading of Shorthand scripts trains the eye to decipher outlines and the
brain to read fast with understanding. If the brain does not
accept, digest and grasp words at least 20 words ahead
of the desired speed, the hand automatically stops writing because it is the human computer (brain) which tells
the outline and directs the hand (instrument) to write. If
the outline is wrong, the eye hesitates and becomes a
hindrance to hand movement. So all the three have to be
trained simultaneously. If the outline is wrongly written it
should be encircled and a fresh outline written instead of
over-writing the written outlines.
Too much movement of hand and turning of pages is time
consuming and wasteful exercise. Concentration and
alertness of mind, knowledge of terminology, spelling, punctuation, meaning, paragraphing, display, phraseography
are necessary for good transcription. Use of tape recorders, slow news bulletins of AIR, TV, in addition to classroom dictation will considerably help the Shorthand writers. Write the same passages (exercises) at higher and
higher speeds to allow free movement of hand.
Method of practice
•

After being fully acquainted with short-forms (outlines
of words, logograms, grammalogues & simple contractions) the use of vowels has to be minimized (using
only essential vowels about which you will learn in the
next chapter. Because vowels are a great hindrance in
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Transcription aids and accurate writing
A number of similar outlines or similar sounding words
confuse shorthand writers, if essential steps are not taken
to distinguish them. The following points should be remembered to avoid confusion.
a) Position (places) of outlines: Always write the outlines according to their places. Put the necessary vowels to distinguish similar outlines. Remember the difference in the following words, meaning of which are
given in brackets:
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a) Similar outlines with different meanins
Word

Meaning

accept

Out lines

Word

Meaning

To receive

Except

Save

Access

Approach

Excess

More than enough

Marry

To wed

Merry

To be happy

Affect

To move

Effect

Result

Tamper

To interfere

Temper

State of mind

Illicit

Unlawful

Elicit

To get

Illegible

Unreadable

Eligible

Fit

Adapt

Fit

Adopt

Use

Imminent

Sure

Eminent

Famous

Precede

Go before

Proceed

To go

Precedent

Previous

President

Presiding officer

Differ

Disagree

Defer

Postpone

Immerse

To sink

Emerse

To dip in water

Out lines

b) Essential Vowels: A preceding vowel is necessary when the words are written on the same places.
Word

Meaning

Outlines

Word

Meaning

Emotion

Mental stage

Motion

Movement

Emission

Result

Mission

service

Auditor

One who audits

Daughter

-

Across

From one to another

Cross

-

A far

Far off

Far

-

Apposite

Suitable

Opposite

Against

Anomaly

Irregularity

Animal

-

Efface

Destroy

Face

-

Aright

Right way

Right

-

Advice

Noun

Device

Method

Advise

To suggest

Devise

To invent

Outlines
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c) Similar Outlines with Different Meanings
A number of words are written or spoken alike but their meanings differ. Such words should be distinguished and spelt
out correctly according to their meanings while using them in sentences:
Word

Meaning

Outlines

Word

Meaning

Emotion

Mental stage

Motion

Movement

Bail

Security

Bare

Only

Bale

Bundle

Bear

To endure

Caste

A race

Berth

Railway sleeper

Cast

To throw

Birth

To take place

Ceiling

Roof/limit

Coarse

Rough

Sealing

To stamp or seal

Course

Range/race

Site

location

Decent

Nice

Cite

To quote

Dissent

Disagreement

Sight

View

Descent

Decline

Council

Assembly

Fair

Beautiful

Counsel

Advice

Fare

Rent for travel

Hale

Healthy

Miner

Sailor

Hail

Come

Minor

Small

Heel

Foot

Male

Masculine

Heal

To cure

Mail

Post

Ordinance

Order

Plane

Smooth

Ordnance

Military stores

Plain

Clear

Suit

Set of clothes

Cease

To end

Suite

Set of rooms

Size

To hold

Stationery

Writing material

Straight

Erect/frank

Stationary

Not moving

Strait

narrow

Lessen

To reduce

Lightening

to light
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Word

Meaning

Outlines

Word

Meaning

Lesson

Learning

Lightning

flash

Human

Man

Divers

Who dive in water

Humane

Kind

Diverse

Different

Morale

Mental make up

Defy

Challenge

Moral

Character

Deify

Worship

Practice

Noun

Principal

Chief

Practise/d

do again

Principle

Conduct

Altitude

Height

Extract

Substance

Attitude

Mental state

Extricate

To release

Outlines
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